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Who

Using This Guide

The Avid® ISIS® media network provides a high-performance distributed file system that
contains high-capacity shared media storage for workgroups of connected Avid editing
workstations. This user’s guide describes how to connect your client system to the media
network, mount workspaces, and configure your system for best performance.

Unless noted otherwise, the material in this document applies to the Windows®, Mac OS® X, and
Linux operating systems.The majority of screen shots in this document were captured on a
Windows system, but the information applies to both Windows and Mac OS X systems. Where
differences exist, both Windows and Mac OS X screen shots are shown.

The documentation describes the features and hardware of all models. Therefore, your system
might not contain certain features and hardware that are covered in the documentation.

Should Use This Guide

This user’s guide is intended for users who need to access workspaces on the Avid ISIS media
network. You should have a basic understanding of how to use and manage the Windows
operating system or the Mac OS X systems, and you should be familiar with basic workgroup
and network concepts.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders,
recommendations, and strong suggestions.

& A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

@ A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.



If You Need Help

Symbol or Convention Meaning or Action

>

(Windows), (Windows
only), (Macintosh), or
(Macintosh only)

Bold font

Italic font
Courier Bold font

Ctrl+key or mouse action

| (pipe character)

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

This text indicates that the information applies only to the specified
operating system, either Windows or Macintosh OS X.

Bold font is primarily used in task instructions to identify user interface
items and keyboard sequences.

Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font identifies text that you type.

Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl-+drag.

The pipe character is used in some Avid product names, such as
Interplay | Production. In this document, the pipe is used in product
names when they are in headings or at their first use in text.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was

published.

New information would be found in the ReadMe file supplied on your Avid software
installation kit as a PDF document and is also available online.

You should always check online for the most up-to-date release notes or ReadMe
because the online version is updated whenever new information becomes available. To
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues.


http://www.avid.com/US/support

Accessing the Online Documentation

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find
answers, to view error messages, to access troubleshooting tips, to download updates, and to
read or join online message-board discussions.

Accessing the Online Documentation

Av

The Avid ISIS online documentation contains all the product documentation in PDF format. You
can access the documentation in the AvidISISDocumentation folder on the Avid ISIS installer
kit. You need to download and install Acrobat Reader on your Avid ISIS before you can access
the PDF documentation.

You need to download and install Acrobat Reader on your Avid ISIS before you can access the
PDF documentation.
To access the online documentation from the installer kit:

1. Insert your Avid ISIS USB flash drive with the Avid ISIS software kit into the USB port.

2. Navigate to the [USB flash drive]:\.AvidISISDocumentation folder, and double-click the
PDF file for the document you want to view.

d Training Services

Avid makes lifelong learning, career advancement, and personal development easy and
convenient. Avid understands that the knowledge you need to differentiate yourself is always
changing, and Avid continually updates course content and offers new training delivery methods
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books,
please visit www.avid.com/support and follow the Training links, or call Avid Sales at
800-949-AVID (800-949-2843).
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K} Avid ISIS Client Manager Setup and
Installation

Most Windows® editing clients require the 1 Gb Intel® Pro 1000 PT or PF Ethernet network
adapter to connect to the Avid ISIS system, even if the clients are connected to an external
switch. For the most up to date list of Windows computers that require the Intel Pro 1000
Ethernet network adapter, see the Avid ISIS ReadMe. Macintosh clients and some Windows
clients have been qualified to use the onboard 1 Gb ports.

Intel Pro/1000 Network Adapter and Driver
Installation

The Intel Pro 1000 Ethernet network adapters are recommended for most Windows editing
systems that connect to the Avid ISIS system. The Intel Pro 1000 PT and Intel i350 T2 are
copper interfaces and the Intel Pro 1000 PF is an optical interface. Depending on the Intel
network adapter used in your system, you must load the appropriate driver from the appropriate
folder. The Intel drivers qualified in this release are included in the Avid ISIS software installer
kit, in the \Drivers\ISIS Client\Intel Pro1000\ folder. Install the newest qualified driver
(Intel xx) in the folder. Check your driver version in the Windows Control Panel.

% For the latest supported Ethernet network adapters and driver versions, see the Avid ISIS
ReadMe that corresponds with your software release.

Intel Pro/1000 Slot Locations

For the correct slot locations for network adapters for client systems qualified with the
Avid ISIS, see the Avid Configuration Guidelines and Clot Configurations Knowledge Base ()
and select the platform you have or are considering.


http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true
http://avid.force.com/pkb/articles/en_US/user_guide/en269631?popup=true

1 Gb Network Adapter Settings (Reference)

Loading or Updating the Intel Pro Driver on Windows Clients

To load the Intel Pro driver on a Windows client:

1. After you install the Intel Pro 1000 network adapter and restart your system, you might
receive a Hardware Wizard message about looking for the Intel Pro 1000 driver. Cancel the
message.

2. Copy the file titled Intel xx.x driver to your client system; found on the Avid ISIS
software kit in the \Drivers\ISIS Client\Intel Pro1000\ folder.

3. Double-click the .exe file to expand the compressed file and run the installer.
4. Accept the default settings to install the driver.
% The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid

ISIS client software the transmit and receive descriptors are set to 1024. For more information,
see “1 Gb Network Adapter Settings (Reference)” on page §.

5. Continue with setting the IP address; see “Configuring the Client Network Properties” on
page 28.

1 Gb Network Adapter Settings (Reference)

When you install the client software and each time you start the Client Manager, especially on
Windows clients, some network adapter settings are checked and changed automatically if
necessary. The following settings for Windows clients are provided for reference.

1 Gb Network Adapters

Option Setting
Receive Buffers 1024
Transmit Buffers 1024

For Macintosh clients, make sure to use the custom driver installer from the Avid kit. On 1 Gb
Macintosh clients, the custom driver sets the MTU value to 1500. No changes are made for
10 Gb Macintosh clients.

The Avid Client installer and Client Manager does not check for or change any network adapter
settings on Linux systems.

12



1 Gb Network Adapter Settings (Reference)

Modifying the 1 Gb Pro/1000 Network Adapter Settings (Windows)

Under normal circumstances, you do not have to change the network adapter settings. The Client
Manager installer checks for specific hardware platforms (Intel, Broadcom, and Myricom) and
makes changes only to those.

If you have a different adapter, you might need to change the settings manually. The following
procedure is provided for reference.
To access the network port properties:

1. Click Start and type devmgmt .msc in the Search text box.

If using Windows 8, you can get to the Search text box by pressing the Windows key on your
keyboard and start typing on the Windows 8 desktop.

The Device Manager dialog window opens.
2. Double-click the Network adapters category to expand the list.
3. Right-click the first Pro 1000 network port and select Properties.
4. Click the Advanced tab.

Intel(R) PRO/1000 PT Dual Pork Server Adapter #2 Properties [ B3

Driver | Deetails | RAesources
Gonersl | Link Speed Advanced | Power Management

( intel‘) Advanced Adapler Setfings

Seflings:

Tnterupt Moderation
Jumba Packe!
Lage Send Offload V2 (IPw)

Large Send Difload V2 (IPwE)

Localy Administered Addhess

[ vert

FotEmaios D |

Configures Ihe edapter to use settings thet can inprove acapter =
performance

-]
oK Cancel

5. Click Performance Options in the Setting list, then click Properties.
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Intel(R) PRO/1000 PT Dual Pork Server Adapter #2 Properties [ B

Performance Dptions [ ]
Settings: Yalue:

Adaitive Inter-Frame Siac\ni Rz & Tx Enabled

Interrupt Moderation Rate
Receive Buffers
Transmit Buffers

Use Default

Flow Control

Enables adapters ta generate or respond fo flow cortrol frames, |
which help regulate network traffic. For an overview of this
featurs, click here

The adapter pauses transmission when it
Txt Enabled
receives a flov cortral frame from @ fink partner.

The adagter genertes @ flow cortral frame
R Enabled  when its recsive quevs reaches a pre-defined |

]

oK Cancel

IS

e.
f.
. C

Intel{R) PRO/1000 PT Dual Port Server Adapter #2 Properties [l B3

" Geneal | LinkSpesed | Advanced Power banagement

(inter) Power Saver and Wake on LAN Options

1 Gb Network Adapter Settings (Reference)

Click Flow Control and set the Value to Rx&Tx Enabled.
Click Interrupt Moderation Rate and set the Value to Enabled.
Click Interrupt Throttling Rate and set the Value to Adaptive.
Make sure that the Receive Buffers Value is set to 1024.

Make sure that the Transmit Buffers Value is set to 1024.

Click OK to close the Performance Options.

lick the Power Management tab.

Driver | Details | Flesaurces |

awier Saver Dptians,

ted
O Reduce link speed duing battery operation
Reduce link speed to save power

Power Saver and %wake On LAN

The options on this tab extendthe copabiiies of the standard =
Povwer Management options. Hgtlighting an option wil cisplay
help information on thet option. Power Saver Options
determing when and how the adapter reduces powsr
consumption

This port does not support Wake: on LAH options.

Cancel

a.

Deselect the “Reduce power if cable disconnected” power saving option.

b. Deselect the “Reduce link speed during standby” power saving option.
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7. Click OK to close the Server Adapter Properties dialog box.

8. (Option) If this is a dual port network adapter, repeat steps 3 through 7 to configure the
second Intel Pro 1000 port.

9. Restart the client system.

Dual Port Network Connections

Dual 1 Gb Ethernet connections allow you to use a dual-attached client for redundancy and
performance enhancements. The dual port Intel Pro network adapter is supported with Windows
clients and the built-in dual Ethernet ports are supported with Macintosh clients. Each port is
configured separately.

When using a dual port configuration, make sure both ports are enabled in the ISIS Client
Manager Network Interface Settings and the network properties (see “Enabling the Network
Interface” on page 51 and “Configuring the Client Network Properties” on page 28). Dual
connected ISIS | 2500 - 2000 and ISIS | 5500 - 5000 clients must be on the same subnet, but
ISIS | 7500 - 7000 clients can connect to the same subnet or to both VLANS for redundancy. The
dual 1 GB connections can be connected to the same ISIS qualified switch. If you have access to
both an ISIS | 5500 - 5000 and an ISIS | 7500 - 7000, one port can be connected to each
infrastructure. Dual 10 GB client connections are supported.

Myricom 10 Gb Network Adapter and Driver

The Myricom® 10 Gb Ethernet adapter is qualified on Windows, Macintosh, and Linux operating
systems for Avid editing ultra high resolution clients (UHRC). These 10 Gb clients connect
directly into the ISIS Engine in a direct connect configuration or to the 10 Gb port of the switch.

If your client cannot connect directly to an Avid ISIS Engine, Avid has qualified several switches
that provide 10 Gb connections. For information on qualified switches, see the Avid ISIS
ReadMe.

The Myricom 10 Gb Ethernet driver is automatically installed on Linux clients when Linux
clients install the ISIS Client software.

Once your Avid ISIS 10 Gb client hardware and software is installed, use the Ultra High
Resolution setting in the Client Manager Preferences with Avid editing clients.
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Installing the Myricom Network Adapter on Windows Clients

The Myricom driver v1.1.10 or later is required for 10 Gb Windows clients. Copy the installer to
your Avid editing client and use the following information to set up the Myricom 10 Gb network
adapter. The Myricom driver can be found in the \Drivers\ISIS Client\Myricom\ folder of
the ISIS software kit.

% The driver installer functions the same whether you are installing the Myricom driver for the
first time or upgrading an existing Myricom driver. If you are upgrading your Myricom driver
start with step 3.
To install the Myricom network adapter and driver in Windows clients:
1. Shut down the Avid editing system.
2. Install Myricom network adapter in the appropriate slot.

For slot information, search the Avid Knowledge Base for System Configuration Guidelines
and Slot Configurations.

3. Copy the Myricom driver from the Avid ISIS software kit to the Windows 10 Gb 64-bit
client.

The Myricom driver can be found in the \Drivers\ISIS Client\Myricom\ folder.

% The Myricom folder contains a 32-bit version for the Windows XP operating system, and a 64-bit
version for the other supported Windows client operating systems.

4. Double-click the myricom 1.1.10 win 32.msi or myricom_1.1.10_win_64.msi installer
and follow the on screen instructions, accepting the default settings.

The installer functions the same whether you are installing the Myricom driver for the first
time or upgrading an existing Myricom driver.

5. Install Avid ISIS client software.

6. Restart the client after the installation is complete.

7. Start the Avid ISIS client software and select the following UHRC requirements:
- Select the Ultra High Resolution setting in the Client Manager Preferences.

- Mount a workspace.

Myricom 10 Gb Network Adapter Settings on Windows Clients

When installing the Client software, the Myricom driver settings are automatically set for you.
The following table provides the Myricom 10 Gb network adapter settings as a reference.
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Myricom 10 Gb Network Settings

Option Setting
Flow Control On
Interrupt Coalescing Delay 2
Receive Buffers 2048
MTU 1500
Receive Side Scaling (RSS) Disabled

Under normal circumstances, you do not have to change the network adapter settings. The Client
installer checks for specific hardware platforms (Intel, Broadcom, and Myricom) and makes
changes only to those.

If you have a different adapter, you might need to change the settings manually. The following
procedure is provided for reference.

To configure the 10 Gb Myricom network adapter in Windows clients:

1. Click Start and type ncpa.cpl in the Search text box.

ﬂ Avid Log Exchange Help and Support

— 8 Avid Interplay Administrator
€Y ratcrie

O Avid Service Configuration
Avid Workgroup Properties

@ Avid Interplay Access

»  AllPrograms

[ nepacpl

e

(On Windows 8, open the Search text box by pressing the Windows key on your keyboard
and start typing on the Windows 8 desktop.)

2. Right-click on the Myricom adapter and select Properties.
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®v|@ < MNetwork and Internet » Network Connections »

Organize «

"-h' Local Area Connection

'kﬁ/ MNetwork cable unplugged

x @7 Broadcom Netitreme Gigabit Eth...
"-h Local Area Connection 4

'kﬁ/ Unidentified network

=4 Myricom Myri-10G Ethernet Adap...

3. Click Configure.

" Lo.cal Are:
§ kﬁl avidww.ct

@D Intel(R) PF

@ Local Area Connection 4 Properties
pe

Networking | Sharing

Connect using:
LF  Myricom Myii-10G Ethemet Adapter

This connection uses the following items:

aClient for Microsoft Networks

4Bl 05 Packet Scheduler

<& Intemet Protocol Version & (TCP/IPvE)
<& Intemet Protocol Version 4 (TCP/IPvd)

& Link-Layer Topology Discovery Responder

.Q File and Printer Sharing for Microsoft Networks
4. Broadcom Advanced Server Program Driver

& Link-Layer Topology Discovery Mapper 1/0 Driver

[ hstal. ][ Unnstal |

Description

network.

Properties

Allows your computer to access resources on a Microsoft

[ ok

] [ cancel

4. Click the Advanced tab.
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Myricom Myri-10G Ethernet Adapter Properties @

Advanced | Driver | Details

The following properties are available for this network adapter. Click
the property you want to change on the left, and then select its value
on the right.

Property: Value:

Flow Cortrol 1500 =
Interrupt Coalescing Delay
IPv4 Checksum Offload
Large Send Offload v2 (|Pv4)
Large Send Offload v2 (IPvE)

Loc:ali Administered Address

Receive Buffers

Receive Side Scaling (RS5)
RSS Queues

Strip VLAN Tags

TCP Checksum Offload (|Pv4)
TCP Checksum Offload (IPvE)

»

m

UDP Checksum Offload (|Pv4) i

oK | [ Cancel

. Click OK.

After changing the Myricom driver settings, restart your client system.

Installing the Myricom Network Adapter on Macintosh Clients

The Avid ISIS software is available on the Avid ISIS Software kit. Load the files on your Avid
editing client and use the following information to set up the Myricom 10 Gb network adapter.

To install the Myricom network adapter in Macintosh clients:

1.
2.

Shut down the Avid editing system.

Install the Myricom network adapter in the appropriate slot. For slot information, search the
Avid Knowledge Base for System Configuration Guidelines and Slot Configurations.

. Double-click the Myri10GE-xx.dmg file to mount the file.

The file (myril0ge-macosx-xx.dmg) can be found on the Avid ISIS software kit in the
Drivers/ISIS Client/Myricom/ folder.

Double-click the Myri10GE-xx.mpkg file to run the installer package.

Follow the on-screen instructions.

Install Myricom driver following the default prompts.

Set the “Myricom Network Adapter Settings on Macintosh Clients” on page 16.
Install Avid ISIS client software.
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8. Restart the client to finish the installation.

9. Start the Avid ISIS client software and select the following UHRC requirements:
- Select the Ultra High Resolution setting in the Client Manager Preferences.
- Mount a 512 KB chunk size workspace.

Myricom Network Adapter Settings on Macintosh Clients

The Myricom 10 Gb network adapter requires the following settings.

To configure the Myricom network adapter in Macintosh clients:

1. On your Macintosh 10 Gb client, click Apple > System Preferences.

Hardware

[

— = &
CDs & DVDs Displays Energy Keyk
Saver

Internet & Wireless

g Z J .

@ K
MobileMe Network Bluetooth Sha
System

2R & b G

2. In the Internet & Wireless section, click Network.

3. In the left pane, select the Myricom entry and click Advanced.
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Location: [Autnmati( N
Ethernet 1 o8
® Connected L4 Status:
Not Connected

@ Etherner 2 & Configure IPv4: | Using DHCP 4

_PCIEth. tSlot2 - G Acdieas:

~ Connected

Subnet Mask:

FireWire
Not Connected

Router:

Y

DNS Server: | \

Search Domains: | ‘

e G @

m Click the lock to prevent further changes. ( Assist me... ) ( Revert ) ( Apply )

4. Click the Ethernet tab (depending on your Mac OS, this selection could be the Hardware
tab).

=% PCI Ethernet Slot 2

! TCP/IP_ DNS WINS | 802.1X | Proxies | Ethernet-}

Ethernet ID: 00:60:dd:46:92:34
!

Configure: [Manuallv ﬂ
Speed: [autosele(t w
| Duplex: { full-duplex, flow-control ﬁ
MTU: [ Standard (1500 44
®

5. Select the following settings.
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Myricom 10 Gb Network Settings

Option Setting
Configure Manually
Speed Autoselect
Duplex Full - Duplex, Flow-Control
MTU Standard (1500)
6. Click OK.

After changing the Myricom driver settings, restart your client system.

Updating the Myricom Driver on Macintosh Clients

The Myricom driver v1.3 or later is required for 10 Gb Macintosh clients with Mac OS v10.7.x
and v10.8.x. Previous versions of the Myricom driver do not work.
To install the Myricom driver on Macintosh clients:

1. Copy the Myri10GE-xx.dmg file from the Avid ISIS software installer kit to your 10 Gb
Macintosh client. The file is located in the following location:
Tools 3rdParty\Drivers and Firmware\Myricom\Mac\ folder.

Double-click the Myri10GE-xx.dmg file to mount the file.
. Double-click the installer package to run the installer.

. Install Myricom driver following the default prompts.

wn oA~ W

. Continue with “Myricom Network Adapter Settings on Macintosh Clients” on page 16.
When you start the Avid ISIS client software, select the following UHRC requirements:
- Select the Ultra High Resolution setting in the Client Manager Preferences.

- Mount a 512 KB chunk size workspace.

Client Software Installation

This section contains information about installing or upgrading the client software on your
system. A user account with Administrator privileges is required to install Avid ISIS client
software on your workstations.
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Loading Client Software

You can load the Client software in the following ways:

*  Use a browser to reach the ISIS Management Console and load it from the System Director.
10 use the ISIS Management Console, you need Adobe® Flash® Player (v11.x or later) installed

on your system. If you encounter problems with the ISIS Management Console display, you might

have an outdated version or multiple versions of the Flash Player installed. Uninstall any

previous versions of Flash Player and install the Flash Player included on the Avid ISIS software
Management Console > Installers page.

*  Download the client installers from the Management Console and copy the software to a
USB flash drive.

»  Store the client software somewhere on the network and allow everyone who needs the
software to gain access to it and load it.

e Select the “ISIS Windows Client” software package from the installer splash screen and
click Apply, which uninstalls the earlier version of the software without having to use the
Windows Control Panel and installs the new software with a single click.

When installing Avid ISIS client software on Windows systems, make sure you are up-to-date
with your Windows critical updates.

To install the client software using a browser:
1. Start your browser application.
2. Run your Windows Update and accept all “High-priority Updates.”
3. Depending on your ISIS system, type the following in your browser.
p  ISIS 5500 — http://IP address of System Director
P ISIS| 7500 and ISIS | 2500 — https://IP address of System Director:5015
If your A\’/id ISIS .network includes a Domain Name Sy.stem.(DNS), you can type the System
Director’s name in the browser (default Virtual name is AvidISIS).
The ISIS Management Console opens.
4. Type your ISIS user name and password.
5. Click the Installers icon.

An Installer Downloads screen opens.
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| Installers

ISISClient
AvidISISClient_el6x86_64_4.7.0_13380.hin
AvidISISClient_MacOSX_4.7.0.13385.dmg

AidISISClient_Win32_4.7.0_13385.msi
AidISISClient_Wing4_4.7.0_13385.msi

ISISEngine
AvidISISStorageManagerbd . msi

151STools
LDAP Sync Tool
LDAPSyncToal_MacOSX_4.7.0_13385.dmg
LDAPSyncToal_Win32_4.7.0_13385 exe
LDAPSyncToal_Wingd_4.7.0_13385 exe
Toolbox
Toolbox_MacOSx_4.7.0_13385.dmg
Toolbox_Win32_4.7.0_13385.axe
Toolbox_Wing4_4.7.0_13385.axe

ThirdParty
flashplayer_11_2_linux_i386 tar.gz
flashplayer_11_2_linux_plugin.i386.rpm
flashplayer_11_2_linux_plugin x86_64.rpm
flashplayer_11_2_linux_x86_G4 tar.gz
flashplayer_11_E_osx.dmg
flashplayer_11_6_win_internet_explorer.exe

flashplayer_11_E_win_plugin.exe

6. Click the appropriate client installer:

» Windows *.msi

» Macintosh *.dmg

P Linux *.bin

You can choose either to save or run the installation software; either is acceptable.
7. Restart the client if prompted.

The client software starts automatically when the client restarts.

ISIS Client Software Installation

Besides the Windows *.msi file available in the Installers page of the Management Console,
Windows clients can install the ISIS Client software using the software kit splash screen.
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Client Software Installation

To install Avid ISIS Windows client software:
1. Log into your Windows client system as a user with Administrative privileges.
2. Load the new software kit on your Windows client system.
3. Double-click the AvidISISSetup.exe file in the software kit.

The installer detects the existing version of the installed client software (if any) and displays
the components that need to be upgraded in the splash screen.

4. Select the “ISIS Windows Client” installer from the Select Software Package menu.
5. Click Apply.
The installer automatically uninstalls an earlier version of software.
6. Update the Intel Pro driver on your client system; see “Loading or Updating the Intel Pro
Driver on Windows Clients” on page 8.
7. Repeat this procedure on each Avid ISIS Windows client.
You can manually copy the client installers to a USB flash drive. The installers are in the Avid
ISIS software kit located on [drive]:\AvidISISClientInstallers. You can also log into the
Management Console and access the Installers link and download the appropriate client
installer.
To install Avid ISIS Macintosh client software:
1. Copy and save the new AvidISISClient MacOSX x.x.x.dmg file from the:
P \AvidISISClientInstallers folder in software kit to your Macintosh client system.
P Management Console > Installer page to your Macintosh client system.
2. Double-click the AvidISISClient MacOSX x.x.x.dmg file.
3. Double-click the AvidISISClient .mpkg file to run the installer.

Follow the on-screen instructions.
The installer replaces any earlier versions of the software.
4. Repeat this procedure on each Avid ISIS Macintosh client.
You can manually copy the client installers to a USB flash drive.

The Macintosh client software installs an uninstaller application located at 2Applications
> Avid Uninstallers > AvidIsIS. Use this application only when you want all Avid
client files removed, including Client Manager preferences.
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To install Avid ISIS Linux client software:
1. Copy and save the new AvidISISClient el6.x86 x.x.x.bin file from the:

P \AvidISISClientInstallers folder in software kit to the user’s home directory of
your Linux client system.

P Management Console > Installer page to the user's home directory of your Linux client
system.

2. Open the Terminal application: Application > System Tools > Terminal on your
Linux client.

When using the Terminal program, file names and paths are case sensitive.

3. Type ¢d [user’s home directory] and press Enter.
4. Type chmod +x AvidISISClient el6.x86 x.x.x.bin and press Enter.
5. Do one of the following.

» Ifyou are not the root user, type sudo ./AvidISISClient el6.x86 x.x.x.bin and
press Enter. You will need to enter your password.

» Ifyou are the root user, type . /AvidISISClient el6.x86 x.x.x.bin and press
Enter.

The installer replaces any earlier versions of the software.

You can manually copy the client installers to a USB flash drive.

mm

6. Restart the Linux client.
To uninstall Linux ISIS client software (and all of the dependencies):
P  Open the Terminal application and type sudo /usr/sbin/avid-isis-uninstaller.

Do not uninstall ISIS Client Manager using the System > Administration > Add/Remove
Program feature. This function does not completely remove all the ISIS Client Manager software.

Configuring Client Software

To mount workspaces on the client do the following:
1. Load the client software as explained in “Loading Client Software” on page 19.
2. Do one of the following:

» (Windows) If the Client Manager icon is not available in the Windows taskbar, select
Start > Programs > Avid > ISIS Client > ISISClientManager.

» (Windows) Click the Client Manager icon in the Windows taskbar.
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(Windows) Right-click the Client Manager icon and select Avid ISIS Client Manager.

4

P (Macintosh) Select Go > Applications, and then double-click the AvidISIS folder. In
this folder, double-click the ISISClientManager.app file.

» (Linux) Click Applications > System Tools and select Avid ISIS Client Manager.

% To add the Client Manager launcher icon to the panel or desktop when using a Linux client, click
Applications > System Tools and right-click Avid ISIS Client Manager and select add launcher to

panel or desktop.
The ISIS Client Manager opens.

3¢ Avid ISIS Client Manager

orkspaces gl gl g (J IF
Swem — [Workwace  Jowme | Reweves | rreo ] |

5 3. (Option) If your ISIS client is connected to Zone 3, select the Remote Host (Avid ISIS
system) the first time you log in. For more information see “Adding a Remote Host” on

page 47.
% The Client Manager user interface can take up to 30 seconds to display changes made in the
Remote Host Settings.
4. Select the ISIS system in the Systems panel.
@ S Click the Connect button in the Systems panel.
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6. Log in using the Username and Password assigned to you by the Avid ISIS administrator. Do
one of the following:

»

(Windows) Type your account name in the Username text box, and type your password
in the Password text box.

(Windows) If your ISIS system is configured to use the Windows user name and
password for your local system, select OS Login. By default, the Username and
Password text boxes are inactive when you select this option.

(Optional — Windows) If you used the OS Login option, and you want to connect to the
network automatically every time you start your system, select the Auto-Connect
checkbox.

(Macintosh) Type your Avid ISIS account name in the Username text box, and type your
password in the Password text box.

(Linux) Type your Avid ISIS account name in the Username text box, and type your
password in the Password text box.

When the connection is successful, workspaces you have been given access to are listed in
the Workspaces list.

Macintosh Operating System

Avid recommends a clean install of the Macintosh OS X (v10.9.x, v10.8.x, or 10.7.x) but an
upgrade to your existing system is supported.

10 use the ISIS Management Console, you need Adobe Flash Player installed on your system.
Macintosh operating systems require the latest versions of Flash Player installed. Download the
Flash Player at http://www.adobe.com.

To install ISIS client software on your Macintosh system:

1. Remove the old version of the ISIS client software using the uninstaller in the
Applications > Avid_Uninstallers folder.

2. Perform a clean install, or upgrade to Macintosh Lion, Mountain Lion, or Mavericks (see
your Macintosh documentation).

3. Install the ISIS client software.

10 Gb Myricom Board Driver Macintosh v10.8.x and 10.9.x Clients

The Avid ISIS software kit includes the 10 Gb Myricom driver for Ethernet Macintosh v10.8.x
and 10.9.x clients. The Myricom driver qualified in this release is included in the Avid ISIS
software kit (\Drivers\ISIS Client\Myricom\myrilOge-macosx-1.3.3avid-1500.dmg).
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Client Software Installation

See “Installing the Myricom Network Adapter on Macintosh Clients” on page 15 for instructions
on installing the 10 Gb adapter boards and the software. Once the Myricom 10 Gb adapter board
is installed, upgrade the driver.

Updating Client Manager Software

Before updating the Avid ISIS Client Manager software on your system, unmount any mounted
workspaces and exit the Client Manager software.

To get started with the client upgrades, you can manually copy the client installers to a USB
flash drive. The installers on the System Director are located on

[drive] :\AvidISISClientInstallers. You can also log into the Management Console and access the
Installers link and download the appropriate client installer.

For Windows clients, uninstall the ISIS client using Windows Control Panel, install ISIS
client, and restart.

The ISIS installer splash screen includes a Windows client software installer. Selecting the
“ISIS Windows Client” software package from the splash screen and clicking Apply,
uninstalls the earlier version of the software without having to use the Windows Control
Panel and installs the new software with a single click.

For Linux clients, installing the new client software updates the previous version.
Preferences are saved and you do not need to restart the client.

For Macintosh clients, installing the new client software updates the previous version.
Preferences are saved and you do not need to restart the client.

If you use the Safari browser to install the Avid ISIS software on a Macintosh client, note
that the disk image is mounted as soon as the download is complete, and the installer starts
automatically. Other browser applications do not automatically mount the disk image.

The Macintosh client software installs an Avid_Uninstall folder. Use this folder only when
you want all of the Avid client files removed; including the preference files.

After the software is successfully installed on your client, dismount the installer volume:

To dismount the Avid ISIS installer volume on a Macintosh client:

1. Locate the mounted volumes listed in the left pane of the Finder window.
2. Select the volume that contains “AvidISIS” in the name.

3. Do one of the following:

P Right-click the volume and select eject.
» Drag the volume to the Trash in the dock and it will eject.
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Client Licensing

Any client that connects to the Avid ISIS system is included in the Avid ISIS client count stored
in the System Director License key. There is no need to order special licenses for each client. If
you are not certain about your license status, see the Avid ISIS ReadMe for number of supported
clients or your ISIS system administrator.

Configuring Network Profiles and Firewalls

When enabled, some Firewall settings on Avid ISIS clients prevent you from connecting to the
Avid ISIS environment. The following sections describe where the network profiles settings are
located in the Client Manager software.

If you are not sure which Firewall profile to use with Windows clients, enable all three Profiles
under Windows Firewall settings. This ensures that the ISIS clients work in all Firewall
configurations.

Configuring Windows Network Profiles

Network profiles are used by Windows Vista to distinguish between Public, Private, and Domain
network connections. Because each network profile uses its own security settings, you must
configure the Client Manager settings so that the appropriate ports are opened for each
applicable network profile on your system.

You only need to configure Client Manager settings for the network profiles that are connected to
your ISIS system. If you are unsure which network connections are used with your ISIS system,
see your network administrator.

To configure the Client Manager settings for Windows network profiles:

1. Verify which network connection profile(s) are used to connect to your ISIS system by doing
the following:

a. Click Start > Control Panel.
The Windows Control Panel opens.
b. Click “Network and Internet.”
The Network and Internet window opens.
c. Click “Network and Sharing Center.”
The Network and Sharing Center window opens.

The Network and Sharing Center window lists the network connections present on your
system and which network profile has been applied to them. The three possible network
profiles are the following:
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- Domain network
- Public network
- Private network

Once you have determined which network profile has been applied to the connection(s) to
your ISIS system, you can go to the next step.

2. Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

® 3. Click the General Preferences button in the Client Manager window.
The General Preferences dialog box opens.

% Windows XP and Windows Storage Server 2003 clients do not have a Windows Firewall section
in the General Preferences window.

EI General Preferences x|

= ]

V=25

Medium Resolution

4. In the Profiles section, click the checkbox next to each applicable network profile type to
enable firewall configuration.

% Enable firewall configuration only for the network profiles that are connected to your ISIS
system.

5. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.
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Configuring the Windows XP Firewall

The Windows XP Firewall is set by default. The Windows Firewall is part of the Security Center
located in the Windows XP Control Panel. The Client Manager installer automatically configures
the Windows Firewall to open the correct ports, but it is possible to have errors if the “Don’t
allow Exceptions” option is selected on the General tab of the Windows Firewall dialog box.

To make sure that the settings are correct when the firewall is enabled:
1. From the Windows Control Panel, open Security Center.
The Windows Security Center window opens.
2. Click Windows Firewall.
The Windows Firewall dialog box opens.

3. Click the General tab, and select On (recommended). You can select Off (not recommended)
if you do not want to enable the firewall.

4. Deselect “Don’t allow exceptions.”
5. Click OK.

Macintosh Support and Firewall

You can use any of the onboard Ethernet ports on the Macintosh system to connect to the media
network. For a list of supported Macintosh systems, see the Avid ISIS ReadMe.

See the documentation provided with your Macintosh system for the exact location of the
Ethernet port.

Some Firewall settings on Macintosh clients prevent you from connecting to the Avid ISIS
environment when enabled. You might receive an error message informing you that no System
Directors were found and that the problem might be the Firewall settings.

Linux Firewall

The Linux client installer configures the Linux Firewall settings for communication between the
Linux clients and the System Director in the Avid ISIS environment.

Configuring the Client Network Properties

Before you can connect your clients to the Avid ISIS network, you must configure the network
properties on each client. If using the default Avid ISIS | 5500 - 5000 setup, you need to set a
static IP address and subnet mask for the Ethernet port connection on every client.
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If your Avid ISIS network includes a DHCP server, clients can automatically obtain

1P addresses. You only need to assign static IP addresses on your Ethernet clients if you do not
have a DHCP server.

Windows Client Network Properties (Other than Windows XP)

To configure the Ethernet port on your Windows clients:

1. Click Start and type ncpa.cpl in the Search text box.

ﬁ Avid Log Exchange Help and Support

@ Avid Interplay Administrator

O Avid Service Configuration
@ Avid Workgroup Properties

@ Avid Interplay Access

»  AllPrograms

[ ncpa.cpl
@

(On Windows 8, open the Search text box by pressing the Windows key on your keyboard
and start typing on the Windows 8 desktop.)

2. Right-click the Local Area Connection and select Properties.

E=SEch =5
@‘v\@« Net.. » Netw.. »

~ [ 43 ||[ Search Network Connections 9|

File Edit View Tools Advanced Help
Organize ~ B O @
Local Area Connection 2

avidww.com

@2 Intel(R) PRO/1000 PT Dual Port Se...

1 item

3. Select the Internet Protocol Version 4 (TCP/IP) option.

4. Click the Properties button. The Internet Protocol Version 4 (TCP/IP) Properties dialog box
opens.
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Internet Protocol Version 4 (TCP/IPv4) Properties l PR X

General | Alternate Configuration

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@) Use the following IP address:

IP address: 192 . 168 . 255 . 100
Subnet mask: 255.255.255. 0
Default gateway:

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[T validate settings upon exit

[ oK ][ Cancel ]

5. In the General tab, select the “Use the following IP address” option.
6. Type a unique IP address in the IP address text box, depending on your configuration:

p  For direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

»  For switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

7. Type the appropriate subnet mask in the Subnet mask text box.

8. (Optional) If connecting to a corporate network or outside the ISIS subnet, add the Default
gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

9. Click OK to close each of the open dialog boxes and save the changes.

Configuring Windows XP Client Network Properties

To configure the Ethernet port on your Windows XP clients:

1. Right-click the Network icon on the desktop, and select Properties. The Network and
Sharing Center window opens.

2. Right-click the Local Area Connection and select Properties.
3. Select the Internet Protocol (TCP/IP) option.
4. Click the Properties button. The Internet Protocol (TCP/IP) Properties dialog box opens.
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Internet Protocol (TCP/IP) Properties 2=l

General |

‘f'ou can get |P zettings assigned automatically if your network, supports
this capability. Otherwise, vou need to ask vour network. administrator for
the appropriate |P settings.

" Obtain an IP address automatically

—* Use the following IP address:

P address: I 192 . 168 . 255 . 101
Subnet maszk: I 285,285 285 0
Default gateway: I . . .

| Obtain DS server address automatically

—* Use the following DMS server addresses:

Freferred DMS server: I . . .
Alternate DMS server: I . . .

Adwanced... |
()8 I Cancel |

5. In the General tab, select the “Use the following IP address” option.
6. Type a unique IP address in the IP address text box, depending on your configuration:

»  For direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

»  For switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

7. Type the appropriate subnet mask in the Subnet mask text box.

8. (Optional) If connecting to a corporate network or outside the ISIS subnet, add the Default
gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.
9. Click OK to close each of the open dialog boxes and save the changes.

10. Close all the remaining open windows and dialog boxes.

Configuring Macintosh Client Network Properties

To configure the Ethernet port on your Macintosh clients:
1. Click System Preferences in the Dock.
2. Click Network.
3. Select the Ethernet port in the left pane.
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ann Network
[«] = ][ Showall Q
Location: | Automatic &
- Etherner 1 s
Connected Status: Connected
Ethernet 1 is currently active and has the IP
@ Fthernet 2 & address 192.168.255.102
@ iF\re.W?ra Configure IPv4: | Manually e ]

IP Address: 192.168.255.102

Subnet Mask: ' 255.255.255.0

Router:

DNS Server:

Search Domains:

( Advanced... ) @

e

ol , N N
'} Click the lock to prevent further changes. [ Assistme.. | [ Revert | [ Apply )

4. In the right pane select Manually from the Configure [Pv4 menu.
5. Type a unique IP address in the IP address text box, depending on your configuration:

p  For direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

»  For switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

6. Type the appropriate subnet mask in the Subnet Mask text box.

7. (Optional) If connecting to a corporate network or outside the ISIS subnet, add the Default
gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

8. (Option) If this is a dual port configuration, repeat steps 3 through 7 to configure the second
Intel Pro 1000 port.

9. Click Apply.
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Configuring Linux Client Network Properties

To configure the Ethernet port on your Linux clients:

1. Click System > Preferences > Network Connections.

A

B Network Connections x
Wired Wireless ‘1’ Mobile Broadband @ VPN DSL
Name lastUsed || Add |
System eth0 nevel
| Close |

. Click the Wired tab (selected by default).

. Select the network connection and click Edit.

B Editing System eth0 x

Connection name: [System etho l

Connect automatically

Wired | 802.1x Security | IPv4 Settings | IPv6 Settings

Method: ‘Manual = ‘
Addresses

Address Netmask Gateway ‘ Add ‘

‘ Delete ‘

DNsservers: | ]

Search domains: l ]

Require IPv4 addressing for this connection to complete

| Routes... |

Available to all users

| Cancel H Apply... ‘

Click the IPv4 Setting tab.
Select Manual from the Method menu.
Click Add.

Configuring the Client Network Properties

Type a unique IP address in the IP address text box, depending on your configuration:

P For direct connect configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS

administrator.
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»  For switch configurations, see the Avid ISIS Setup Guide or ask your Avid ISIS
administrator.

8. Type the appropriate subnet mask in the Netmask text box.

9. (Optional) If connecting to a corporate network or outside the ISIS subnet, add the default
gateway and DNS server addresses.

See your corporate administrator for the Default gateway and DNS server addresses.

10. (Option) If this is a dual port configuration, repeat steps 3 through 7 to configure the second
Intel Pro 1000 port.

11. Click Apply.

10 Gb Network Connections

%

The 10 Gb network adapter can connect directly into the 10 Gb port on the Avid ISIS | 5500 -
5000 Engine or the 10 Gb port on the switch. On Avid ISIS | 7500 - 7000 Engines with two ISS
switches installed, two Avid ISIS clients with 10 Gb network adapters can be connected (one to
each ISS) or the 10 Gb port on the switch. Clients with 10 Gb network adapters access to the
Avid ISIS 2500 through a 10 Gb port on a switch.

If your client cannot connect directly to an Avid ISIS Engine, Avid has qualified several switches
that provide 10 Gb connections. For information on qualified switches, see the Avid ISIS
ReadMe.

For information on configuring the ISIS switches, see the Avid Network and Switch Guide in the
documentation folder of the Avid ISIS software kit [drive]:\AvidISISDocumentation.

Configuring 10 Gb Client Connections

@

Some client configurations might require that the 10 Gb network adapter is the only active
network interface available to ISIS. If this is the case, you need to disable the other network
interfaces, including the corporate uplink, in the Client Manager network preferences. Do not
disable the NIC using the Windows OS.

Disabling a network card in the Client Manager Preferences makes the card unavailable only to
Avid ISIS. It does not affect the card’s functionality in the operating system or any other
applications.
To ensure that the 10 Gb connection is the primary connection:
1. Start the Client Manager application.
2. Click the Network Interface Settings button from the toolbar of the Client Manager window.
3. Verify that the 10 Gb network adapter appears in the network interfaces list and that Enabled

is selected.
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The Network Interfaces dialog box opens.

# Network Interfaces =

Local &
e ArER 10.101.25.119  Intel(R) PRO/1000 MT Network Connection
Connection 2

etz 1010125145 Mygicom hyri-1 03 Bthernet Ad
{Connection 5

v

4. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.

10 Gb Client Resolution Settings

Avid ISIS editing clients with a 10 Gb network adapter installed should use the Ultra High
Resolution setting in the Client Manager Preferences.

If using the 10 Gb network adapter in an Avid Interplay server for the Copy/Move Service, use
the Medium Resolution setting.

To select the for the resolution preference:

1. Click the General Preference Settings button from the toolbar of the Client Manager
window.

The General Preferences dialog box opens.
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Ed General Preferences

= ]

V=25

Medium Resolution

2. In the Client Type drop down, select “Ultra High Resolution.”

3. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.
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EJ Using Avid ISIS Client Manager

Avid ISIS Client Manager allows your client to connect to the Avid ISIS shared storage network.
When you install the Avid ISIS Client, the Client Manager runs in the background so you can
mount and access your workspaces at any time, as well as manage your workspaces and
bandwidth reservations. On Windows clients an icon appears in the System Tray in the lower
right corner of your desktop. On Macintosh clients, an icon appears in the dock. When you open
the application and log in, the Client Manager displays all available System Directors and all
available workspaces.

The Client Manager allows users with the necessary account privileges to specify client
bandwidth reservations, if any.

Client Manager Window

The following illustration describes the sections of the Client Manager window.



Client Manager Window

Avid ISIS Client Manager

AvidlSIS @ administrator Online

| Y J Search Workspaces

(Gsom— [vorcapsce  Jomne | Wose | emove ]

AvidISIS-HLT workspace @ v 10:30:26 am
AvidISIS-NLT workspaced i @ W

AvidISIS-NLT workspace2 @ x
[ |

Level Time Message

IHF O FriWar 25 1318:57 2011 Connection establizhed to system "AvidISIE" by user "administrator” B
IHFC Fribar 25131549 2011 Connection established to system "AvidISIS" by user "administrator” n
IHF O FriMar 25 1318:57 2011 Connection to workspace WAvIdISISWCapture workspace has been established. .

BICM Cui hdme T8 A 20d 0038 ACA e s mdime b s sl mmm 40 AT T ik e 1l i mmim, L, Lemmm b bl b ) [ |

1 Client Manager Tool bar — change preferences or access help

2 Systems list — lists all available and connected ISIS systems:
ISIS | 5500 - 5000 and ISIS | 7500 - 7000 systems are listed as “Online”
ISIS | 2500 - 2000 is listed as “Nearline”

3 System bandwidth area — bandwidth settings (hidden by default), display setting is in the General
Preference Setting dialog window

4 Workspaces list — lists all workspaces available on connected ISIS systems

5 Workspaces details area — retrieves details about all available and/or mounted workspaces in the
workspaces list

6  Messages area — Log of information, warnings and error messages
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Client Manager Buttons

Client Manager Buttons

The following table describes the Client Manager buttons. You can also hold the cursor over the
button and get a tool tip on the button function.

The visibility of these icons depends on other settings.

Button

Location

Function

Client Manager
window toolbar

Client Manager
window toolbar

Client Manager
window toolbar

Client Manager
window toolbar

Client Manager
window toolbar

Client Manager
window toolbar

Toggles the “Systems” pane in the Client Manager window to display
or be hidden

Toggles the “Logs” pane in the Client Manager window to display or

be hidden

Opens the General Preference Settings dialog box

Opens the Remote Hosts Settings dialog box

Opens the Network Interfaces Settings dialog

Opens the Advanced Settings dialog
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Button

Location

Function (Continued)

English

vV & ©

vt

Client Manager
window toolbar

Client Manager
window toolbar

Systems toolbar

Systems toolbar

Systems toolbar

Systems toolbar

Systems toolbar

Systems toolbar

Selects the country language displayed in the Client Manager
window. The following languages are available.

* Arabic

* English
* French

*  German
» Ttalian

e Japanese
» Korean

* Russian

« Simplified Chinese
* Spanish

Opens the Client Manager Help. Help is available in the language
matching the language displayed.

Connect to the selected ISIS systems

Disconnect from the selected ISIS systems

Opens the Management Console for the selected systems

Change password for the current user

Reserve Bandwidth

Configure Reserve Rate
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Client Manager Buttons

Button Location Function (Continued)
Systems toolbar Toggle Auto Reservation
&
Systems Login Icon representing a client user
H

fﬁ:-

¢ & W

e

@ <

Systems Login

Systems Login

Workspaces toolbar

Workspaces toolbar

Workspaces toolbar

Workspaces toolbar

Workspaces toolbar

Workspaces toolbar

Icon representing the client user has OS Login selected

Icon representing the client user has Auto Connect selected

Mount Selected Workspaces

Unmount Selected Workspaces

Assign Mount Point to Selected Workspace

Toggle Auto Mount Workspaces

Retrieve Details for the mounted workspaces

Retrieve Details for all workspaces
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ISIS Shared Storage Network Connection

Button Location

Function (Continued)

Logs toolbar

2

Advance settings and
common in Client
Manager windows

Common in Client

ED:I Manager windows

Common in Client
Manager windows

Common in Client
Manager windows

Common in Client

@ Manager windows

Saves the messages displayed in the current Client Manager window,
the default location is:

* (Windows) C:\Program Files\Avid\ISIS Client
¢ (Macintosh) [Drive]:/Users/USERNAME

Client Manager logs are automatically saved even when the Save Log
Message button is not clicked. Logs are saved in the following
location:

*  (Windows) C:\Users\USERNAME\AppData\Local\Avid\ISIS
ClientManager\Logs

* (Macintosh) [Drive]:/Users/ USERNAME/Library/Application
Support/Avid/ISISClientManager/Logs

Clears the cache saved on the client system in the Advance Settings or
clears the entry in dialog boxes

Adds new entry to the dialog box

Deletes the selected entry from the dialog box

Applies settings or changes made in the open dialog box

Closes the open dialog box. Any changes that were not applied
reverted back to the last saved settings

ISIS Shared Storage Network Connection

The Client Manager software automatically checks for System Directors on the Avid ISIS shared
storage network. ISIS | 5500 - 5000 and ISIS | 7500 - 7000 System Directors display as “Online”
in the System Type column of the Client Manager, the ISIS | 2500 - 2000 displays as “Nearline.”
Once the Client Manager software has been configured, the Client Manager can reconnect
automatically when you restart your system.
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ISIS Shared Storage Network Connection

If your system is a Zone 3 or a Zone 4 client, add the remote server IP address for your System
Director. For more information, see “Adding a Remote Host” on page 47.

For information on Avid ISIS zone descriptions, see “Avid ISIS Client and Zone Descriptions”
on page 47.

Fast User Switching Not Supported

Fast User Switching is a Windows feature that allows multiple user accounts to log on to a
computer simultaneously. Fast User Switching is enabled by default in Windows computers. The
Fast User Switching feature and multiple concurrent logged on user modes are not supported in
the Avid ISIS environment. The ISIS software does not distinguish the different drive letters
mapped to the same workspaces on the same computer. Conflicts appear in the following
scenarios:

*  When one user maps a drive letter to one workspace and another user maps the same drive
letter to a different workspace

*  When one user maps a workspace to one drive letter, and another user maps a different drive
letter for the same workspace.

Connecting to the ISIS Shared Storage Network

If your system is connected to an Avid ISIS shared storage network, you can use the Client
Manager to mount a workspace before you begin your work session.

To connect to the Avid ISIS network:
1. Do one of the following:

» (Windows) If the Client Manager icon is not available in the Windows taskbar, select
Start > All Programs > Avid > ISIS Client > ISIS Client Manager.

» (Windows) Click the Client Manager icon in the Windows taskbar.
P (Windows) Right-click the Client Manager icon and select Avid ISIS Client Manager.

(Macintosh) If the Client Manager alias icon is not available, select Go > Applications,
and then double-click the AvidISIS folder. In this folder, double-click the
ISISClientManager icon.

» (Linux) If the Client Manager alias icon is not available, click Applications > System
Tools and select Avid ISIS Client Manager.

2. Select the System Director you want to connect to from the Systems list.

If this is the first time connecting, identify your System Director; see “Adding a Remote
Host” on page 47.

3. Connect by doing one of the following:
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ISIS Shared Storage Network Connection

P  Click the Connect button.
P Right-click the System Director name and select Connect.
» Double-click the System Director name.

4. Log in by doing one of the following:

» (Windows) Type your account name in the Username text box, and type your password
in the Password text box.

» (Windows) If your ISIS system is configured to use the Windows user name and
password for your local system, select OS Login. By default, the Username and
Password text boxes are inactive when you select this option.

P (Macintosh) Type your ISIS account name in the Username text box, and type your
password in the Password text box.

» (Linux) Type your ISIS account name in the Username text box, and type your password
in the Password text box.

5. Click Connect.

When the connection is successful, the Change Password and Launch Management Console
buttons become active.

6. (Option) if you used the OS Login option, and you want to connect to the network
automatically every time you start your system, select the Auto Connect box.

Client Manager Tray Icon (Windows and Linux)

When the Client Manager is running, an icon appears in the system tray. The tray icon color
indicates the client connection status:

Icon Status

Client Manager is running, but there are no active ISIS connections.

e

Client is connected to one or more ISIS systems, but there are no mounted workspaces.

e

Client is connected to one or more ISIS systems, and there are one or more mounted
workspaces.

Indicates a connection error.

B B
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ISIS Shared Storage Network Connection

If you hover the mouse cursor over the tray icon, a tooltip containing additional information
appears:

-Ml:uunted workspaces: ZI
BN & w4eu

Changing Your Password

You can use the Client Manager to change the password you use to log on to your Avid ISIS user
account.

If your user name and password are different for your client system and your Avid ISIS account,
your system cannot automatically reconnect to the media network when you restart your system.
To change your Avid ISIS account password:

1. Open the Client Manager (see “Connecting to the ISIS Shared Storage Network™ on
page 43).

2. Log into the ISIS system for which you want to change your password, if you are not
already.

3. Click Change Password.

The Change Password dialog opens.

8 Change password for 1 system ﬂ
Uzer hame: administrator LI
System Mame: AvidISIS

Old Pazsword:
Mew Passward:

Confirm Mew Passward:

After changing your password, you will need to reconnect.

v

4. Type your existing password in the Old Password text box.

5. Type your new password in the New Password text box.
The Client Manager supports only ASCII characters in user passwords.

6. For confirmation, type the password again in the Confirm New Password text box.
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ISIS Shared Storage Network Connection

7. Click the green check mark to apply the changes or click the red X to close the dialog box
without any changes.

Opening the ISIS Management Console from the Client Manager

You can open the ISIS Management Console from the Client Manager window after you have
connected to an ISIS system. From the Management Console login screen you can access the
complete Management Console documentation using the Help link.

To open the ISIS Management Console:

e P Select one or more systems in the Systems section of the Client Manager window and click
& the Management Console button.

Your default web browser opens to the ISIS Management Console login window.

% The ISIS Management Console display might differ according to your user account’s access
privileges.

12:44:22

02/05/2013 03:24:1;1 S YSTE M To o I. S

ﬂ Workspaces g' System Status History

ﬁ Installers

Megabytes per second

0

Total Bandwidth
0 MBps
0 MBps
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ISIS Shared Storage Network Connection

Avid ISIS Client and Zone Descriptions

All clients in the media network are classified by zones, depending on how they connect to the
network. The following list defines the clients in each network layer by its zone classification:

»  Zone 1 Client — Connected to ISIS VLANS via an ISIS | 7500 - 7000 ISS or ISIS | 5500 -
5000 System Director port (direct connect)

e Zone 2 Client — Connected to ISIS VLANS via an Avid qualified layer-3 switch
(non-routed)

*  Zone 3 Client — Connected to an Avid qualified layer-3 switch (routed) with known Quality
of Service (QoS); traffic routed to ISIS (one hop) and load-balanced across ISIS VLANs
(~60/40 ratio)

*  Zone 4 Client — Connected to the house network using an edge or a core switch with
unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and
load-balanced across ISIS VLANSs (approximately a 60/40 ratio)

% Clients supported in one zone can also run in any lower-numbered zone — for example, a Zone 3
client can also run as a Zone 2 or Zone 1 client.
Support for different client and device types vary by zone:
* Zone 1 — AirSpeed playout, Transfer Manager
*  Zone 2 — AirSpeed ingest, editors, Interplay
e Zone 3 — Instinct, Assist, certain editors

*  Zone 4 — Instinct, Assist; typical formats include DV25, MPEG-2 proxy (2 Mb/s)

Adding a Remote Host

If your client is not on the same subnet as the ISIS shared storage network, you need to add the
name of your System Director in order for the Client Manager to connect to it. If your system
does not use a DNS server to configure your network connections, you can also type the IP
addresses of the remote host, but you cannot use the virtual server name or virtual IP addresses.

C.'lientiv on the same subnet as the ISIS Systen? Director, automatically have the System Director
listed in the toolbar of the Client Manager window.
To add a remote host:
1. Open the Client Manager (see “ISIS Shared Storage Network Connection” on page 42).
The Client Manager opens.
2. Click Remote Host Settings.
The Remote Hosts dialog box opens.
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¥ g Remote Hosts x|

Enter Remate ISIS Server Host Mame

ByidlSIS_Svstem Q ' d

10105161185

v

3. In the text box, type the actual server name or IP address of the Avid ISIS System Director to
which you want to connect.

You cannot use the virtual server name or the virtual IP address of the remote host.

4. Click Add.
The Input dialog box opens.

5. In a Dual System Director configuration, enter both System Director names or IP addresses.
You cannot use the virtual server name or the virtual IP address of the System Directors.

6. Click Add.

% The Client Manager user interface can take up to 30 seconds to display changes made in the
Remote Host Settings.

7. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.

To remove a System Director from the Remote Hosts list:

P Select the System Director name and click Remove.

To remove all System Director names from the Remote Hosts list:
» Click Clear.
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Setting the Client Manager Display Properties

Display properties in the Client Manager control how the application displays information on
your local system.

To set Client Manager display properties:

1.

Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

window.

. Click the General Preference Settings button from the toolbar of the Client Manager

In the General area, select the appropriate options:

Option

Description

Start Client Manager Hidden

Use UNC (Letterless)
Drive Mappings

Enable Automatic Refresh

Enable Bandwidth Columns

Display Bandwidth in Bits
Per Second

Measure Free Space In

Client Type

Windows Firewall:

Enable domain network
Enable public network

Enable private network

(Windows and Linux) Allows the Client Manager to run hidden and
accessible from the Client Manager icon in the taskbar. Deselect this
option to open the Client Manager each time you start your system.

(Windows) Use UNC paths to map workspaces instead of drive letters.

Automatically refreshes the data in the Systems and Workspace panels; for
both Windows and Macintosh clients. This option is enabled by default.

Displays the bandwidth buttons and columns in the Client Manager. Also
enables some additional buttons, including the “Display Bandwidth in Bits
Per Second” option.

Displays bandwidth in bits per second. When deselected, the displayed
bandwidth is in bytes per second.

Displays the amount of available space in your workspace either in
gigabytes (GB) or in the total length of stored media
(hours:minutes:seconds) at a selected resolution.

Selects a client type. For information on client types, see “Setting Client
Types” on page 50.

(Windows) Enables the firewall profile configurations used in your ISIS
shared storage network.

any changes.

4. Click the green check mark to apply the settings or the red X to close the dialog box without
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ISIS Shared Storage Network Connection

Set your client type to match your network path capability:

Resolution Setting

Use with:

Low resolution

Medium resolution (default)

High resolution

Ultra high resolution

Interplay Assist Zone 4 (no QoS Guarantees using a less than optimal path)
Avid editing systems using MPEG-2 resolutions.
All non-real time applications such as Copy/Move services (even with a 10 Gb

connection), MPI Server, AirSpeeds, FTP transfers, and any third party transfer
devices

Avid editing systems using DV25/IMX30 resolutions

DNxHD® and uncompressed Standard Definition (SD) resolutions being used with a
realtime editor

Avid editing systems or Avid Interplay Assist using Avid DNxHD® resolutions like
DNxHD 145/120 or DV50/IMX-50 or uncompressed Standard Definition

Clients with dual 1 Gb connections, or a single or dual 10 Gb connection using the

highest resolutions (DNxHD and uncompressed SD) on a realtime time editor

Avid editing systems with 10 Gb Ethernet connections supporting clients editing in
Uncompressed HD and multiple DNxHD/SD stream counts

To set a client type:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

2. Click the General Preference Settings button from the toolbar of the Client Manager

window.

The General Preferences dialog box opens.

Windows XP clients do not have a Windows Firewall section in the General Preferences window.
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El General Preferences

=

DW-25

Medium Resolution

3. In the General area, click the Client Type menu, and select the appropriate client type:
» Low Resolution
P Medium Resolution (default)
» High Resolution
» Ultra High Resolution

4. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.

Enabling the Network Interface

Only network interfaces involved with communicating with the ISIS system should be enabled.

To select the Network Interface:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

2. Click the Network Interface Settings button from the toolbar of the Client Manager window.
The Network Interfaces dialog box opens.
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ISIS Connection Tests

# Network Interfaces i
[Enabled | Hame [ IPAddress

| LDCEIAFFE 10.101.25.119  Intel(R) PRO1000 MT Network Connection
... Connection

v %

3. Make sure your ISIS Ethernet network connection is selected.

4. Click the green check mark to apply the changes or click the red X to close the dialog box
without any changes.

ISIS Connection Tests

Before you begin using the Avid ISIS shared storage network, test the connection to your
workspace to make sure communication between your client system and the media network is
sufficient for the functionality needed by your system.

Use the Avid PathDiag tool, which installs with your client software, to test the read/write
throughput, or the rate that read and write operations are conducted between your client system
and a mounted workspace.

For a complete guide to using the Avid PathDiag tool, see “Avid PathDiag Tool” on page 63.

Mounting and Unmounting Workspaces

Your Avid ISIS user account must have access to at least one workspace. For information on
workspace access, see “Creating Client Accounts for Users” in the Avid ISIS Administration
Guide.

When you have one or more workspaces mounted and the connection to the System Director is
subsequently lost, a message appears in the Log pane of the Client Manager window. The Client
Manager icon in the Taskbar changes color (for Windows systems).
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Mounting and Unmounting Workspaces

The Client Manager then automatically attempts to reestablish the connection with the System
Director. When the connection is successfully reestablished, a Log message informs you of the
connection state.

& Linux clients must always unmount workspaces before exiting Client Manager or your
mount points could be different the next time you start the Client Manager and mount
them. If you do not unmount the workspace, that workspace will appear as
</mnt/workspace nameI> in the Online column the next time you start the Client Manager.
To correct the issue, you need to delete the /mnt/ <workspace name> directory on the client
system.

For information on opening the Client Manager, see “Connecting to the ISIS Shared Storage
Network™ on page 43.
To mount an Avid ISIS workspace on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for Workspaces that are
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
P Select a workspace and click the Mount button.
P Right-click a workspace and select Mount.
» Double-click the workspace.
» (Option) Right-click, and select “Assign Mount Point” from the menu.
% Selecting this option will override the current drive mapping option settings for the selected

workspace. For more information on drive letter assignments, see “‘Configuring Workspace
Mount Points” on page 535.

The Client Manager mounts the selected workspace on your client and the Online icon for
the mounted workspace changes to green. (Windows) The Workspaces list displays the drive
the workspace is mounted to. If you use letterless drive mappings, the Workspaces list
displays “UNC path” next to the Online icon. (Macintosh) Displays the path to the mount
point.

If you manage your lettered or UNC workspace mounts outside of the Client Manager
application (for example, Map Network Drives) you can create multiple mount points to the
same workspace. Client Manager will display the multiple mounts properly.

3. (Option) If you want the selected workspace remounted the next time you log in, do one of
the following:

P Select the workspace and click the Toggle Auto Mount button.
» Right-click the workspace and select “Enable Auto Mount.”
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The next time you log in to your client system, the Client Manager automatically mounts the
selected workspace.
To mount multiple Avid ISIS workspaces on your system:
1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
» Select multiple non-contiguous workspaces with Control+click.

P Select a range of contiguous workspaces by clicking on the first workspace row in the
range, then Shift+clicking on the last.

» Select all workspaces by right-clicking in the Workspaces list and selecting “Select All.”
P Select all workspaces by pressing Control+A.
3. Right-click, and select Mount.

The Client Manager mounts the selected workspaces on your client and the Online icons for
the mounted workspaces change to green. The Workspaces list displays the drives the
workspaces are mounted to. If you use letterless drive mappings, the Workspaces list
displays “UNC path” next to the Online icons.

If you manage your lettered or UNC workspace mounts outside of the Client Manager
application (for example, Map Network Drives) you can create multiple mount points to the
same workspace. Client Manager will display the multiple mounts properly.

4. (Option) If you want the selected workspaces remounted the next time you log in,
right-click, and select “Enable Auto Mount.”

The next time you log in to your client system, the Client Manager will automatically mount
the selected workspaces.
To unmount an Avid ISIS workspace on your system:
1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are
already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
P Select a workspace and click the Unmount Selected Workspace button.
P Right-click on the workspace and select Unmount.
The Client Manager unmounts the workspace from your client, and the green icon is

removed from the Online field for this workspace.

When you exit the Client Manager you are offered the option of unmounting Workspaces.
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To unmount multiple Avid ISIS workspaces on your system:
1. Make sure your Avid application is not running.
2. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that are
already mounted. You can filter the Workspaces list by Workspace name.

3. Do one of the following:
» Select multiple non-contiguous workspaces with Control+click.

P Select a range of contiguous workspaces by clicking on the first workspace row in the
range, then Shift+clicking on the last.

P Select all workspaces by right-clicking in the Workspaces list and selecting “Select All.”
P Select all workspaces by pressing Control+A.

4. Click the Unmount Selected Workspace button or right-click and select Unmount.
The Client Manager unmounts the workspaces from your client, and the green icons are

removed from the Online field for those workspaces.

When you exit the Client Manager you are offered the option of unmounting Workspaces.

Configuring Workspace Mount Points

The Client Manager allows you to configure the drive letter used when mounting Avid ISIS
workspaces. This allows you to prevent workspaces from being assigned drive letters you want
reserved for other uses.

The Client Manager skips fixed drives and drive letters that are already in use.

If your system requires using Universal Naming Convention (UNC) paths for all mounted
workspaces rather than drive letters, you can use Client Manager to set this as the default
mapping for workspaces.

If you manage your lettered or UNC workspace mounts outside of the Client Manager
application (for example, Map Network Drives) you can create multiple mount points to the
same workspace. Client Manager will display the multiple mounts properly.

To configure the drive letter for mounting workspaces:

1. Open the Client Manager (see “Connecting to the ISIS Shared Storage Network™ on
page 43).

2. Select a workspace from the Workspace list.
3. Right-click the selected workspace, and select “Assign Mount Point” from the context menu.

The Assign Mount Point dialog box opens.
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% The Macintosh and Linux dialogs are different, the UNC does not apply but you can select the
default or manually entered mount point.

¥ Assign Mount Poink: Cap |

% hlext avaiahle drive letter (7
" Select drive letter I j

£ UNGC (i Avid SIS Capture workspace)

v X

. Click the Choose drive letter menu, and select the drive letter you want to use for mounting

workspaces.

Option Description

Next available drive letter (letter:) Mounts the workspace to the next available drive letter,
working backward from drive Z:

Select drive letter Mounts the workspace to the selected available drive letter.

UNC (\\path) (Windows) Uses a Universal Naming Convention (UNC)

path for the mounted workspace instead of a drive letter.

. Click the green check mark to apply the settings or the red X to close the dialog box without

any changes.

Workspace Display

The Workspaces list provides basic information about each workspace, including the following:

All available workspaces

Connection status (connected, not connected, automounted)

Drive letter (Windows), UNC path, or Mount point for the mounted workspace
Workspace name

System Director name

Workspace details retrieval time

Free space in gigabytes (displayed units depend on the General Preference settings)
Workspace total capacity in gigabytes

Used space (as a percentage of available capacity)
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*  Protection type

»  User privileges for the workspace (read, read/write)

Retrieving Workspace Details

When you connect to an ISIS system, only the workspace names are displayed; you need to
retrieve additional workspace details manually. You do not have to mount a workspace to retrieve
its details.

To retrieve details for one or more selected workspaces:
1. Do one of the following:
P Select a single workspace by clicking on a workspace row.
P Select multiple non-contiguous workspaces with Control+click.

» Select a range of contiguous workspaces by clicking on the first workspace row in the
range, then Shift+clicking on the last.

2. Right-click in the Workspace list, and select Retrieve Details > Selected Workspaces.

Additional details are retrieved for the selected workspaces.

To retrieve details for all mounted workspaces:
» Do one of the following:
- Click the Retrieve Details for Mounted Workspace(s) button
- Right-click in the Workspace list, and select Retrieve Details > Mounted Workspaces.

Additional details are retrieved for all mounted workspaces.

To retrieve details for all workspaces:
» Do one of the following:
- Click the Retrieve Details for All Workspaces button
- Right-click in the Workspace list, and select Retrieve Details > All Workspaces.

Additional details are retrieved for all workspaces.
Sorting the Display

If the Workspaces list contains a large number of workspaces, you might want to sort the items in
the list.

To sort the Workspaces list:
1. Click on a field heading that you want to sort.

A blue arrow appears next to the field heading.
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2. Click the field heading again to reverse the sort order.
Filtering the Display

If the Workspaces list contains a large number of workspaces, you might want to filter the items
in the list.

To filter the Workspaces list:

»  Type part or all of a workspace name in the “Search Workspaces” field.

The Workspaces list updates to display the workspace names that match the text entered.

To display all Workspaces:
» Delete the text in the “Search Workspaces” field.
The Workspaces list updates to display all available Workspaces.

Accessing the Help

The Client Manager Help provides background information for tasks, windows, and dialog
boxes. The Help system is QT-based and opens in a separate windows.

To open the Client Manager help:

» Inthe Menu panel, click the Help button.

Bandwidth Reservations

You can use the Client Manager to obtain a default bandwidth reservation; however, the
reservation cannot exceed your system’s device limit or your client bandwidth limit, whichever is
lower. The reserved bandwidth is the total bandwidth available to the client; the sum of both
reads and writes. The Avid ISIS system enforces an effective bandwidth limit based on either the
client type specified by the Client Manager or the reserved bandwidth value set in the
Management Console. Your Avid ISIS administrator sets the bandwidth limits, and the
bandwidth limit is listed in the Workspaces list. For more information on using the Management
Console to set bandwidth limits, see the following topics in the Avid ISIS Administration Guide:

* Adding Users
* Adding Devices

*  Configuring Management Console Preferences
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Setting a bandwidth limit on editing clients can adversely affect playback performance. Avid
recommends that you do not set bandwidth limits for users other than Avid AirSpeed® clients.
However, your administrator might need to set a bandwidth limit for other devices, such as an
Avid ISIS TransferManager, in the event the device is consuming more bandwidth than expected.

Enabling Bandwidth Reservations

The Bandwidth dialog must be enabled in order to manage bandwidth reservations.

To enable the Bandwidth Dialog:

1.

6.

Open the Client Manager.

2. Click the General Preference Settings button.
3.
4. (Option) Select “Display Bandwidth in Bits Per Second” to display bandwidth in bits per

Select “Enable Bandwidth Columns.”

second instead of megabytes per second.

Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.

The Bandwidth buttons appear in the Systems toolbar.
To set the Bandwidth (see “Creating or Releasing Bandwidth Reservations” on page 59).

Creating or Releasing Bandwidth Reservations

A9

This procedure assumes that there are existing bandwidth reservations on the ISIS Management
Console for the device (client system) or the users of the client system. On the client system, you
can further restrict the bandwidth to less than the limit set on the ISIS.

To create or modify a bandwidth reservation:

1.

2.

Open the Client Manager and Enable Bandwidth Columns in the General Preference
Settings (see “Enabling Bandwidth Reservations” on page 59).

Click the Configure Reserve Rate for Selected System(s) button.

The Configure Reserve Rate dialog box opens.
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Administrative Tasks

Configure Reserve Rate il

—Reserve Rate

|4 3: stream(z) of DY-25 L|

= 15.00 MB/s ,L (exceeds limits)

—FRate Reservation Limits

U=ser Limit: 0.00 Bis (from reserve limit)

System Limit: 0.00 Bis (fram reserve limit)

3. Use the up/down buttons to select the number of streams you will need.

4. Select the type of stream from the list.

There are several presets for various formats, as well as numeric bandwidth values.

If the selected bandwidth value exceeds the limits imposed either by the client type specified by
the Client Manager or the reserved bandwidth value set in the Management Console, a warning
symbol will appear next to the Total Rate value. You can save these values, but cannot create or

modify an existing reservation.
5. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.
6. Close the Configure Reserve Rate dialog.
7. Click the “Reserve bandwidth for selected System(s)” button.

You can enable Auto Reserve and create the reservation in one step by selecting “Toggle Auto
Reservation for selected System(s)” instead of clicking Reserve.

8. (Option) If you want the reservation to be created automatically the next time you log in,
click the “Toggle Auto Reservation for selected System(s)” button.
To release a reservation:
1. Select the System reservation you want to release.
2. Click Reserve bandwidth for selected System(s).

The selected reservation is released.

Administrative Tasks

Review your logs and messages and clear cached data on a regular basis.

64



Administrative Tasks

Clearing Cached Data

The Client Manager maintains information on site settings in cache files, and the tool appends
data each time you open the Client Manager. You can clear the cached information — for
example, to remove settings for users no longer working on a specific system — by deleting the
cache files.

To clear cached data:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

2. Click Advanced Settings.

3. In the Advanced section, do one of the following:
» Click Clear for each cache file you want to clear.
» Click Clear All to clear all cached data.

4. Click the red X to close the dialog box.

Managing Logs and Messages

The Client Manager keeps a log of information, warnings, and error messages. You can view the
current log in the Messages section of the Client Manager window. You can also save a copy of
the log, and you can clear the log maintained for the current work session.

The Client Manager clears all logs when you exit the application.

To view Client Manager event logs:

1. Open the Client Manager. (For information on opening the Client Manager, see “ISIS
Shared Storage Network Connection” on page 42.)

The Messages area is the bottom section of the Client Manager window. You can sort the
Messages list by clicking the Level, Time, or Message field heading and clicking on the blue
arrow to sort in ascending or descending order.

To save a copy of the event log:
1. Right-click in the list, and select Export.
The Export dialog box opens.
2. Navigate to the folder where you want to save your log.
3. Type a name for the log in the File Name text box.
4. Click Save.

The Client Manager saves the event messages as a log file (filename.log).
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To clear all event logs:

P Right-click in the list and select Clear.
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EJ Avid PathDiag Tool

Avid PathDiag tool is a diagnostic utility that allows you to validate your Avid ISIS storage
group by quantifying the throughput of Windows or Macintosh editing applications accessing
Avid ISIS workspaces. The Avid PathDiag tool can also test the throughput from local storage
elements and any other shared storage to which a client has access.

Starting Avid PathDiag Tool

To start Avid PathDiag tool, do one of the following:
» (Windows) Select Start > All Programs > Avid > ISIS Client > PathDiag.

P (Macintosh) Select Go > Applications, and then double-click the AvidISIS folder. In this
folder, double-click the PathDiag icon.

The Avid PathDiag tool opens.



PathDiag Tool Interface
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PathDiag Tool Interface

The primary user interface of PathDiag tool consists of a single window from which you can
select the test to be performed, start and stop the selected test, and view the test results as the test
progresses. You access auxiliary controls through dialog boxes.
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PathDiag

Furg Read MBFE
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* 1 — Settings area

* 2 — Messages area

¢ 3 —Results area

* 4 — Control area

* 5 — Start and Stop buttons
¢ 6 — Test results graph

e 7 — Zoom slider control
Settings Area

The Settings area in the main window displays the name of the currently selected test, the test
duration, and the path to the storage that will be tested.

The Setup button allows you to change the test settings. For more information, see “Diagnostic
Tests” on page 68.
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Control Area

The Control area in the main window has Start and Stop buttons along with test timing
information. For more information, see “Starting and Stopping the Test” on page 75.

Messages Area

The Messages area provides test progress and diagnostic information about the operation of the
utility. If you need to troubleshoot, the detailed text information in these messages might be
helpful.

Results Area

The Results area provides the following numerical test results:

Item Description
10s Displays the current number of I/0 operations that have been completed during the
test

Current Rate (MB/s) Displays the calculated throughput or bandwidth (in megabytes per second
[MB/s]) for recent I/O operations that have been completed

Average Rate (MB/s) Displays the average throughput or bandwidth (in megabytes per second) for the
duration of the test

Errors Displays the number of errors encountered during testing. This is the total of all
errors generated for both read and write operations and can include errors related
to the following:

*  Opening or closing data files
« Validity of the specified file system path
» User access privileges

* Read or write operations

Text indicators on the left of the Results area show the file access protocol used and the operation
performed in the current phase of testing.

The File Access Protocol indicator shows one of the following:

Item Description

Automatically  Selects a protocol automatically for testing the selected path. Generally, the tool selects
Select Win32 File API for the specified path
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Item Description

Win32 File Indicates the Win32 file access API is being used. This indicator is displayed for local
API disks, mounted ISIS workspaces, and network file shares.

Self-Test Indicates the performance monitor runs a test without actually performing any read or
write operations. This is usually done to benchmark the tool without disk input/output
actions affecting the results.

The I/0 Operation indicator shows one of the following:

Item Description
(Reading) The current mode of testing is Read operations.
(Writing) The current mode of testing is Write operations.

Test Results Graph

The Test Results graph plots results measured over time. It is particularly useful when you want
to observe trends or patterns in performance.

For example, if another process is running that creates a periodic high demand on the storage
subsystem being tested, you might see this as a periodic drop in observed throughput in the Test
Results graph.

The Test Results graph shows the following:

Item Description

Average Read or  The average throughput or bandwidth (in megabytes per second), plotted over time.
Average Write

Recent Read or The calculated throughput or bandwidth (in megabytes per second) for recent I/O
Recent Write operations, plotted over time.

Peak Read or Peak The peak latency for individual I/O operations (either reads or writes) that have been
Write MS/100 completed over a short period of time. A high measurement indicates a longer period
of time was needed for the operation to complete.

Because only the highest (peak) measurement over a short period of time is
displayed, a single high peak could be accompanied by many low-latency operations
that do not appear in the graph.
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% When you run the Network Connectivity test, the Test Results graph display is replaced with a
table of results generated by the test. For more information, see “Setting Up a Network
Connectivity Test” on page 73.

Diagnostic Tests

The Settings area of the PathDiag tool displays the currently specified test parameters. Before
running the test, you must mount at least one workspace in the Avid ISIS shared storage
network.

Setting Up a Standard Test

To change the default test settings:
1. Click the Setup button.
The PathDiag tool Settings dialog box opens.

Avid PathDiag Settings

Cancel

Optional Log Files...

2. Adjust the test parameters using the information provided in the following table, the ISIS
Read/Write Test Name selection is recommended.

72



Diagnostic Tests

Parameter Description

Test Name The following are predefined selections that perform either read or write testing at a
bandwidth similar to that required for DV 25, DV 50, IMX 30, or low resolution
operation.

* DV 25 Reads

* DV 25 Writes

* DV 50 Reads

* DV 50 Writes

e 4:1s Writes

e 10:1m Writes

* 14Z:1 Writes

*  IMX 30 Reads

*  IMX 30 Writes

» ISIS Read/Write (see the statement below this table)

Path to Test ~ Select the path to the workspace you want to test, or type it in the text box.
This can be a UNC path (for example, \\myMachine\ myShareFolder\subfolder).

Duration Select the test duration (in minutes), or type a duration in the text box. The minimum test
(Minutes) duration is 1 minute.
Loop Select the Loop option to repeat the test indefinitely. When you select this option, the test

proceeds until you press the Stop button in the main utility window.

The Loop option causes true loop behavior: at the end of the specified duration, the test
stops, intermediate test files that have been created are cleaned up, and then the test
restarts using cleaned-up intermediate test files.

The ISIS Read/Write test is a good standard test because it includes unlimited bandwidth
used to ascertain the available performance of the end-to-end path. The following are typical
results:

- Single 1 Gb connection produces an average of 96 MB/s
- Dual 1 Gb connection produces an average of 192 MB/s

- Single 10 Gb connection produces an average of 250 MB/s on writes and 350 MB/s on
reads

- Dual 10 Gb connection produces an average of 500 MB/s on writes and 700 MB/s on
reads
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Diagnostic Tests

3. If necessary, specify paths and file names for optional test and error log files as follows:
a. Click Optional Log Files.
The Avid ISIS PathDiag Optional Log Files dialog box opens.

Avid PathDiag Optional Log Files

Indicate fully qualified path and log fi

Log File:
——

Error File:

—— -

b. If you want to log information about the test and its results, type a path name and a file
name in the Log File text box, or click Browse to search for a file name.

c. Ifyou want to log error information, type a path name and a file name in the Error File
text box, or click Browse to search for a file name.

If you do not want a log file, leave the Log File, Error File, or both text boxes blank.
d. Click OK to close the dialog box.

Setting Up a Custom Test
In addition to the standard, predefined tests, the PathDiag tool allows you to configure custom
tests:

« To view the selection of standard tests, click Standard Tests in the PathDiag tool Settings
dialog box.

¢ For 10 Gb connections, the recommended Transfer Size is 32768 with a Transfer Rate of
unlimited.

To access the custom test settings options:
1. Click Custom Test in the PathDiag tool Settings dialog box.
The dialog box expands to display the Custom Test Settings area.
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Avid ISIS PathDiag Settings 3

2 -
 —

Optional Log Files... Custom Test 353

2. Adjust the custom test parameters described in the following table, as required:

Parameter Description

File Access PathDiag tool supports more than one interface or protocol for accessing data. This

Method option allows you to control which interface is used. Choose one of the available
settings:

+ Automatically select — PathDiag tool selects a protocol automatically for testing
the selected path. Generally, the tool selects Win32 File API for the specified
path.

*  Win32 File API — PathDiag tool uses the Win32 File API for its data file access.

* Network Connectivity Test — PathDiag tool runs a high-level test to verify
network connectivity. For more information on the network connectivity test, see
“Setting Up a Network Connectivity Test” on page 73.

»  Self-Test — PathDiag tool runs a test without actually performing any read or
write operations. This is usually done to benchmark the tool without disk
input/output actions affecting the results.

75



Diagnostic Tests

Parameter

Description (Continued)

Reads vs Writes

Transfer Size
(KB)

Transfer Rate
(KB/S)

Max File Size
(MB)

PathDiag tool supports testing that focuses on Reads or Writes, or that alternates
between Reads and Writes. Select a testing mode:

*  Writes, then Reads — The utility alternates between Write and Read tests.
Approximately half of the test duration is allocated to reading, and the other half
is allocated to writing.

*  Writes Only — The utility writes test data files and measures the throughput
obtained during Write operations.

* Reads Only — The utility reads test data files and measures the throughput
obtained during Read operations.

% One or more test data files are written as sample data for testing, however, the
Writes required to set up the test are not included in the throughput
measurements.

This option controls the amount of data the test utility attempts to read or write during
a single I/0. Some software (like audio applications) uses smaller I/Os. Video
applications use larger I/Os. Depending on the client application, you can select a
typical I/O size for your application and run a PathDiag to see the results that you can
expect from your client running that application.

In some cases, you might set the Transfer Size to large I/O sizes to test switch
performance.

The utility can attempt to perform I/O at a variety of fixed transfer rates. This is useful
for simulating the behavior of applications that have a known data rate. You can select
a data rate where I/Os do not exceed a particular limit.

A special unlimited transfer rate setting is also available. When you select the
unlimited transfer rate, the PathDiag tool performs I/O operations as fast as possible
while being affected by all aspects of the total system being exercised.

This option controls the maximum size of test data files created for Reads or Writes.
This option might affect throughput measurements. For example, at any given data
rate, a smaller file is opened and closed more often than a larger file, creating more
overhead. The default file size is 100 MB.

The Max File Size setting is very useful when creating custom PathDiag tests. If you
use any of the default sizes on an ISIS | 5500 - 5000, you are doing I/O nearly 100%
out of cache, rather than disk I/O. This is great in determining the health of your
network, by taxing the network. If you want to test pure disk I/O throughput, run
multiple instances of PathDiag using the largest supported file size of 2000 MB.

76



Diagnostic Tests

Parameter

Description (Continued)

Use named
common file for
Reads

This option changes the way that the Path to Test parameter is used, and the option is
intended for advanced users only. When you select this option, the Path to Test
parameter must specify a full path, including a file name. The test utility uses the
named file for its Read tests.

The utility creates the file if it does not exist and deletes it at the end of testing. For
this reason, the named file should not already exist unless you want it to be deleted
when the test is completed. With this option selected, you can run PathDiag tool on
multiple clients simultaneously and supply the same file name.

This allows PathDiag tool applications running on multiple clients to read a common
file. (The file is created as needed, and the last PathDiag tool application to stop
deletes the file.)

3. Click OK.

Setting Up a Network Connectivity Test

The PathDiag tool provides a high-level verification of network connectivity when you select
Network Connectivity Test as a custom test parameter. The Custom Test Settings area of the
Avid ISIS PathDiag Settings dialog box allows you to list up to 8 network hosts to test. Results
display in the Test Results graph area of the PathDiag tool.

To set up the Network Connectivity Test:

1. Click Custom Test in the PathDiag tool Settings dialog box.

The dialog box expands to display the Custom Test Settings area.

2. Select Network Connectivity Test from the File Access Method menu.

The Network Hosts list displays the available systems in your network.

Avid PathDiag Settings

st N2 st -]

Optional Log Files: << Standard Tests
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3. Type the host name or the IP address of the network system you want to test.

4. (Option) Set the Ping Data Buffer Size. The default buffer size is 8192 bytes, and the
maximum buffer size is 64 KB.

5. Click OK.

When you run the Network Connectivity test, results display in the Test Results graph area
of the PathDiag tool.

The following table describes the test results.

Network Connectivity Results

Category Description

Source The IP address of the client system

Target The host name and IP address of the target system
Sent The number of packets sent

Recv The number of packets received

Lo RTT (ms) The minimum round-trip time (in milliseconds)
Hi RTT (ms) The maximum round-trip time (in milliseconds)
Avg RTT (ms) The average round-trip time (in milliseconds)
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Network Connectivity Results (Continued)

Category Description

Lo Hops The minimum number of forwarding routers in the path between the source and the
target system

Hi Hops The maximum number of forwarding routers in the path between the source and the
target system

Avg Hops The average number of forwarding routers in the path between the source and the
target system

% Lost The percentage of the packet lost in the test

Starting and Stopping the Test

You start and stop the currently configured test using the Start and Stop buttons.

To start the currently configured test:
p  Click Start in the PathDiag tool main window.

The test runs for the specified duration and then stops automatically. The elapsed time a test
has been running and the remaining time are displayed in the Control area. If you selected
the Loop option in the PathDiag tool Settings dialog box, the test runs indefinitely. In this
case, the word LOOP appears in the Time Remaining display in the main window.

To stop the currently running test:

» Click Stop in the PathDiag tool main window.

Test Results

This section provides information to help you interpret test results displayed in the PathDiag tool
main window.

Average Rate Calculation

The average data rate is calculated over the duration of the test. This calculation includes the
time the utility requires to open and to close the test files, so the test file size (which you can
configure for custom tests) can affect the overall measured throughput.

Also, if the throughput is slow as the test is starting, this might be reflected in the average rate.
For example, if the target bandwidth is 4.0 MB/s, the actual average rate calculated at the
conclusion of the test might be 3.98 or 3.99 MB/s.

79



Test Results

Performance Graph

The graph of results over time can help experienced users obtain information about system
performance.

The following display is a normal unlimited read/write profile for an ISIS client.

PathDiag
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Look for the following:

*  Trends: Does the system perform at a consistent rate over time? Is there an upward or
downward trend in performance measured over time? If you notice a trend, it might be
helpful to perform testing over a longer period of time to determine if the trend continues
over longer durations or if a recurring pattern emerges.

It is normal for the maximum read bandwidth to be greater than the maximum write
bandwidth.
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Test Results

»  Patterns: s there a momentary drop in performance that occurs at consistent or varied
intervals? Patterns can emerge as a result of implementation details and the configuration of
a particular system (for example, caching strategies or physical memory), or they might
indicate a load on a system that is occurring periodically.

*  Changes in performance as load varies: What occurs when a subsystem is placed under a
load by other users (or PathDiag tool is running on another client)? It might be easier to
observe these interactions by inspecting the plot of performance results over time.

Measurement Strategy

Throughput measurements are plotted periodically (approximately every 5 seconds) and
represent a snapshot of performance at the time of the plot. This limits the amount of data that is
plotted, which otherwise could include a very large number of data points. As a result, the
performance graph could miss a momentary drop or increase or a peak in performance that
occurs between plot points. The average rate calculation reflects the impact of such a dip or
spike, even if the actual size of a momentary variation does not appear in the graph.

Test Result Interpretation

If your results fall below optimal performance, check to see if your bandwidth is limited. You
can use the Avid ISIS Management Console to check your user bandwidth in the Users list in the
Users dialog box (see “User Descriptions” in the Avid ISIS Administration Guide) and your
device bandwidth in the Device list in the Device dialog box (see “Device Descriptions” in the
Avid ISIS Administration Guide). If your bandwidth requirements are greater than the
reservations set in the Management Console, your Avid ISIS administrator can adjust the limits.

These results represent guidelines for Avid-qualified systems; performance on your system
might vary.
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K} Data Migration Utility

Data

The Data Migration Utility copies data from workspaces between an Avid MediaNetwork
infrastructure and an ISIS infrastructure, or (as of the ISIS v4.5 release) between two ISIS
infrastructures. You use Ethernet connections between the client and both Avid ISIS systems, or
a Fibre Channel connection between the Avid MediaNetwork and the client.

You can use the Data Migration utility to copy data between any combination of ISIS | 7500 -
7000, ISIS | 5500 - 5000, and ISIS | 2500 - 2000 workspaces (this includes mirrored, RAID 5,
RAID 6, HW Raid, SW Raid, and unprotected workspaces).

When you copy data from an ISIS | 5500 - 5000 or an ISIS | 2500 - 2000 system to an ISIS | 7500
- 7000 system, the utility automatically creates mirrored workspaces on the ISIS | 7500 - 7000 by
default. After the data has been copied, you can change the protection type if you want.

Migration Between Avid Storage Networks

A Data Migration Utility is included with Avid ISIS software kit for copying data from

Avid MediaNetwork v5.1.3 and v4.2.4 infrastructures to the Avid ISIS infrastructures, or
between ISIS infrastructures. Data Migration software is not supported in MediaNetwork v4.1.6
and older infrastructures.

ISIS clients can be directly connected to the ISIS systems or through an ISIS switch. As you
copy the selected Workspaces from one shared storage infrastructure to the other, the utility

creates Workspaces with the same name on the targeted ISIS infrastructure automatically. A
progress bar is displayed to monitor the status of your migrations.

Do not migrate data from the same workspace with multiple clients at the same time.

Data Migration clients requirement:

1. Update your Windows or Macintosh client to the appropriate Avid MediaNetwork and Avid
ISIS client software versions.

2. Connect your shared storage network cables:

»  Avid Unity MediaNetwork client — Fibre Channel connection to the Avid Unity
MediaNetwork.



Data Migration Between Avid Storage Networks

»  ISIS Windows client — to the Intel Pro 1000 PT network adapter on your Windows
client.

p  ISIS Macintosh client — to the built-in Ethernet port on your Macintosh client.
3. Load the ISIS client software and any updates required for the release.

4. Load the Avid Data Migration software, see “Installing the Data Migration Utility” on
page 80.

Operating Systems Qualified for Data Migration from MediaNetwork

The following lists the client operating systems that have been qualified for data migration from
Avid MediaNetwork to Avid ISIS.

*  Windows 7 (64-bit) with SP 1

*  Windows Vista (64-bit) with SP 2

*  Windows XP (32-bit) with Service Pack (SP) 3

*  Windows 2008 R2 (64-bit)

«  Mac OSX-Lion v10.6.5, v10.7.x, and Mountain Lion v10.8.x

Starting with the v4.5 release, data migration between two ISIS systems is supported with any of

the currently supported client operating systems. See the latest ReadMe for a list of supported
client operating systems for ISIS.

Macintosh Client Requirements for MediaNetwork

Data Migration has been qualified on Mac OS with Avid MediaNetwork v5.3.3 or later and Avid
ISIS v3.2 or later. Make an Ethernet connection to the ISIS 5000 v3.2 or Avid ISIS 7000 v2.4
and later infrastructures, and a Fibre Channel connection to your Avid MediaNetwork v5.1.3 or
v4.2 .4 infrastructures. Using the Data Migration Utility clients can copy data files from the Avid
MediaNetwork to ISIS infrastructures.

Windows Client Requirements for MediaNetwork

Data Migration has been qualified on Windows clients with Avid MediaNetwork v5.4 or later
and Avid ISIS | 5500 - 5000 v3.2 or later. An Ethernet connection is made to the Avid

ISIS 5500 | 5000 v3.2 or Avid ISIS | 7500 - 7000 v2.4 and later infrastructures, and a Fibre
Channel connection to your Avid MediaNetwork v5.1.3 or v4.2.4 infrastructures. Using the Data
Migration Utility clients can copy data files from the Avid MediaNetwork to ISIS infrastructures.

Dual connected clients are supported only with the ATTO FC-41ES network adapter in
supported Windows client systems and slots. The ATTO FC-41XS and FC-41EL Fibre Channel
network adapters, and Windows client systems not listed are not supported.
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Installing the Data Migration Utility

Installing the Data Migration Utility

%

To install the Data Migration Utility:
1. Load the Avid ISIS client software and any updates required for the release.
2. Restart the ISIS client.

3. Load the Avid Data Migration software. The Avid Data Migration software can be found in
the Avid ISIS software installer kit in the following location \AvidISISUtilities\ISIS
Data Migration Utility\ folder. Double-click the appropriate installer and follow the
prompts.

»  Windows 32-bit clients — AvidISISDataMigrationUtility_ Win32.msi

The Windows software is loaded in the following location: \Program
Files\Avid\Data Migration Utility.

»  Windows 64-bit clients — AvidISISDataMigrationUtility_ Win64.msi

The Windows software is loaded in the following location: \Program
Files\Avid\Data Migration Utility.

» Macintosh clients — AvidISISDataMigrationUtility_MacOSX.dmg

The Macintosh software is loaded in the following location: /Applications/Avid/
Data Migration Utility.

4. Log into your ISIS Management Console and create a new Storage Group for the new
Workspaces getting copied from your MediaNetwork shared storage environment.

There must be a Storage Group created on your ISIS system before you start the Data Migration
Utility.

Logging Into the Data Migration Utility

The Data Migration Utility login requires the Administrator password for both your
MediaNetwork and your ISIS storage shared storage networks.

The Data Migration Utility is _for copying data from the Avid Unity MediaNetwork to Avid ISIS
and between ISIS shared storage networks. This utility does not copy data from ISIS to the
MediaNetwork.
To connect to the Avid ISIS network:

1. Load the Data Migration software (see “Installing the Data Migration Utility” on page 80).

2. Click Start > Programs > Avid > Data Migration Utility, and select Data Migration Utility.
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Data Migration Window
The System Login Dialog box for both the MediaNetwork and the ISIS shared storage
systems opens.

% The system shown in the Source list varies depending on whether the source is a MediaNetwork
or another ISIS system.

% System Login E

Saurce Destinstion

AuidISIS =l

& Administrstor
3 R

v %

MEDIANET-ENGINEFC =

& Administrstor
3 R

I EEEEEEEREERE]

3. Log in using your Administrator account (Administrator is already entered):
a. Type your MediaNetwork Administrator password in the Source text boxes.
ok b. Click Connect or press Enter.
c. Type your ISIS Administrator password in the Destination text boxes.
d. Click Connect or press Enter.

4. Click the green check mark to log in or click red X to close the utility.

Data Migration Window

The following illustration describes the sections of the Data Migration Utility window.
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Data Migration Window
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1 Data Migration toolbar — contains buttons for connecting or disconnecting to the shared storage
environments, hiding the Verify and Copy Data and Transfer Queue panels, and opening the Transfer
Preferences and Help dialog boxes.

2 Selection area — for selecting the MediaNetwork workspaces to be copied to the ISIS.

3 Storage Group area — lists the workspaces, total amount of data to be copied, and estimated amount
of transfer time. The name of the destination Storage Group is listed and whether there is enough
unallocated space in the Storage Group for the selected Workspaces to be copied.

4 Workspace area — lists the Workspace names, their destination, amount of data and estimated
amount of time to be copy each Workspace, and position of the Workspace in the transfer queue.

5 Data Migration button — Starts the file coping after you have selected the Workspaces to copy and
Storage Group destination. This button is not active if the destination Storage Group is not large
enough.

6  Transfer Queue area — provides you with the ability to view the transfer progress, pause or cancel
the transfer, and view logs of the transferred and failed files
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Data Migration Buttons

Data Migration Buttons

The following table describes the Data Migration Utility buttons. You can also hold the cursor
over the button and get a tool tip on the button function.

Button Location Function

. dh System Login Opens the System Login dialog box to connect to both shared storage
e dialog box systems

o Data Migration Disconnect from both shared storage systems

B window toolbar

G

l_‘l

FelHEBE@®

Data Migration
window toolbar

Data Migration
window toolbar

Data Migration
window toolbar

Data Migration
window toolbar

Select Workspaces
toolbar

Select Workspaces
toolbar

Select Workspaces
toolbar

Select Workspaces
toolbar

Verify and Copy
Data toolbar

Toggles the “Transfer Queue” panel in the Data Migration window to
display or be hidden. The Transfer Queue shows the data migration
logs which includes a list of files that have been transferred and any
files that might have failed the transfer.

Toggles the “Select Workspaces” and “Verify and Copy Data” panels
in the Data Migration window to display or be hidden. The Select
Workspaces panel lists all the Workspaces and Allocation Groups or
Storage Groups in both the MediaNetwork and ISIS systems.

Opens the Transfer Preferences dialog box

Opens the Client Manager Help. The Client Manager Help includes
information on the Data Migration Utility.

Selects all the MediaNetwork Workspaces to be copied

Deselects all selected MediaNetwork Workspaces

Refresh all the data; in both the MediaNetwork and ISIS Storage
Groups

Refreshes the display to show the number of new files on the source
MediaNetwork Workspace since the time of the last migration.

Data Migration button starts the copy from MediaNetwork to ISIS.
This button is disabled if the amount of data in the source is greater
than destination capacity.
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Running the Data Migration Utility

Button Location Function (Continued)
j Transfer Queue Clears the Transfer Queue panel of Completed, Failed and Canceled
g toolbar transfers. This button does not clear Active, Pending and Paused
transfers.
Transfer Queue Pauses the process of the data being copied. Press the Pause button

toolbar again to continue the copy.

Transfer Queue Cancels the selected transfers
toolbar

toolbar successfully

D Transfer Queue Opens log file displaying the files that have, and have not transferred
i
a Transfer Preferences Applies settings or changes made in the open dialog box

dialog box
Transfer Preferences Closes the open dialog box. Any changes that were not applied
@ dialog box reverted back to the last saved settings

Running the Data Migration Utility

After installing the Data Migration Utility and logging in as previously described. The following
procedure describes how to copy your data from the MediaNetwork to the ISIS. When you select
the Workspaces to copy on the source system, and a Storage Group on the ISIS, the utility
automatically creates Workspaces on the ISIS system with the same names as the Workspaces
used in the source environment. If the capacity of ISIS Storage Group does not have enough
space, the Data Migration button (used to start the copy) does not become active.

Once you have started coping files, you can pause and continue the copy at any time. If you
cancel the copy operation, any files already copied to the ISIS can be used.

You do not need to mount Workspaces using the MediaNetwork Fibre Manager or the ISIS Client
Manager to use the Data Migration Utility.
To copy data:

1. Open the Data Migration Utility. (See “Logging Into the Data Migration Utility” on
page 80.)

2. Select one or multiple Workspaces in the Select Workspaces list.

3. Choose your destination Storage Group on the ISIS.
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Transfer Preferences

The ISIS Storage Group must be already available before you start the Data Migration Utility.

Select Workspaces E:‘} kﬂ @ @

= Big Aliocation Group 27123 GB 1.895TH storage group L]

&) Editor Allocation Group1 13612 GB 500.00 GB storage group 1=

il Mac Allocation Group2 1.39GB 100.00 GB storage group |  3/31/2011 3:29:09 PM

@] Small Allocation Group1 148.00 MB 10.00 GE storage group z 3/30/2011 4:27:04 PM

| Thousand Allocation Group1 9.77 GB 15.00 GB storage group :_| 28/2011 2:34:57 PM

il UnMirrored Allocation Group 102.91 GB 1000.00 GB {storage group v,

| Workspace Allocation Group2 0.00 1416 TB storage group v

@] WS16 Allocation Group2 395.00 MB 100.00 GE storage group z 3/30/2011 4:27:08 PM
o—— 0 0000 ]

@ 4. Click Start Migration button to begin migration.

This button is disabled if there is not enough space in the destination Storage Group or you
have not selected all of the required parameters. If the connection is lost, the disconnection
event displays in the Transfer Log.

Status bars show progress in Transfer Queue.

5. (Option) Check the logs regarding transfer result.

To stop a transfer:
ﬁ P Select one or more transfers in the queue and click Cancel.

If no transfers are selected, this button is disabled.

To view the files that have not been copied:
1. Select the Workspace.
@ 2. Click New File Refresh.

The New Files column lists the number of new files in the selected Workspace not
previously transferred.

Transfer Preferences

You can set the following options in the Transfer Preferences dialog box.

*  Preserve file and directory timestamps — When checked the timestamps associated with the
files and directories are copied to the ISIS system. If unchecked the current date is used.

*  Overwrite existing files — If there are existing files with the same name as the files being
copied, the existing file is overwritten with the file being copied. If Workspaces or folders
already exist, files are added to those existing Workspaces and folders.
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Transfer Queue and Logs

e Overwrite files even if timestamps are the same — This setting is available when “Overwrite
existing files” is checked. Files are overwritten regardless of the date on the timestamp.

*  Overwrite read-only — This setting is available when “Overwrite existing files” is checked.
Files are overwritten even if the file is read-only.
To set the Transfer Preferences:

1. Open the Data Migration Utility. (See “Logging Into the Data Migration Utility” on
page 80.)

The Data Migration Utility opens.
2. Click the Transfer Preference button in the Data Migration Utility window.

The Transfer Preferences dialog box opens.

B Transfer Preferences Ei

[¥ Preserve file and directory timestamps
[~ Cwerwrite existing files

[ Owerwrite files even it timestamps are the same

[~ Owerwrite read only files

3. Select your preferences.

4. Click the green check mark to apply the settings or the red X to close the dialog box without
any changes.

Transfer Queue and Logs

The Data Migration Utility keeps a log of Files Transferred and Files Failed. You can view the
current log in the Transfer Queue section of the Data Migration Utility window. The log file is
automatically deleted and a new one is started every time you open the Data Migration Utility.
You can save a copy of the log or the log for the current work session.

The Data Migration Utility clears all logs when you exit the application.



Transfer Queue and Logs

To view data in the Transfer Queue:

1. Open the Data Migration Utility. (See “Logging Into the Data Migration Utility” on

page 80.)
i If the Transfer Queue area is not displayed, click the show Transfer Queue button to display
L‘J) the panel.

The Transfer Queue area is the bottom section of the Data Migration Utility window. You
can sort the list in the window by clicking the headings at the top of the Transfer Queue
panel. Click the blue arrow to sort the Workspace field in ascending or descending order.
To save a copy of the Data Migration Utility log:
D 1. Click in the Transfer Log file button.
1
The Log file opens in your text editor.
2. Navigate to the folder where you want to save the log.

3. Type a name for the file and save it.

To clear transferred file data in the Transfer Queue panel:

j » Click Clear.

This clears any finished transfers (those that have been canceled, failed, or completed). Any
pending or paused transfers remain in the queue.
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I ISIS Log Utility

The ISIS Log Utility used by Avid Customer Support shows the logging information of the ISIS
client connection. This utility is installed with the ISIS client software and is used to diagnose
client issues. This updated utility has a common user interface for Windows, Macintosh, and
Linux clients.

*  You can load predefined profiles (based on common troubleshooting scenarios) that use
trace filters to gather data.

* The Log Utility automatically compresses and timestamps continuous logs.
»  After you “Take Snapshot” of the loaded Profile results, you can save the snapshot to a file.

*  Through the counseling of Avid Customer Support, you can also add specific Profiles to the
list.

Running the ISIS Log Utility

To run the Log Utility:
1. Do one of the following:
» (Windows) Click Start > Programs > Avid > ISIS Client > ISIS Log Utility.

» (Macintosh) From the Finder, click the Go menu and select Application > AvidISIS >
ISISLogUtility.app.

» (Linux) Click Application > System Tools > ISIS Log Utility.



-

@, Avid ISIS Log Utility

= -] |

Logaing Profiles

Loaded Profile: <User Modified>
Select Profile: |Redistribuh’0n problems vl
| Load | | configure | | Add/Remove |
Logging
| Take Snapshot |
. Elapsed Continuous Log:
| Save Snapshot | 00:00:15
| Start Continuous Log | Crittla
L J 03/04/2013 09:13:51
| Clear Log |
Tools
| CurentSettrgs | | Show Display |

| Re-read Registry

Delete All Log Files |

Running the ISIS Log Utility

. Based symptoms the client is experiencing, select a profile from the Select Profile menu:

- Default — Use this profile if you are unsure of which profile to use. These logs capture
general ISIS client problems.

- Client Hang — Capture these logs if the ISIS client stops functioning and you want to
see if the unexplained client failure is associated to ISIS functions. This should be used
if the editor stops while capturing, playing, consolidating, or transcoding to an ISIS
Workspace. Many of these failures could be an issue with the editor.

- File or Workspace Access — Capture these logs if the ISIS client cannot mount
Workspaces, access files within a workspace, or received errors when accessing

Workspace files.

- I/O Timeouts — Capture these logs if the ISIS editing client displays “semaphore
timeout” messages, “delayed write failures,” or dropping frames while working with
media on a Workspace.

- Redistribution Problems — Capture these logs if the ISIS client is experiencing errors,
displaying messages, or dropping frame while the ISIS system is in the process of a
redistribution. Although client performance is expected to drop during and an ISIS
redistribution, these problems would be under light ISIS loads and low resolutions.

. Click Load.

The configuration for the selected Profile is loaded.
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Changing Settings

4. (Option) Click “Current Settings” to change settings in the configuration.
5. Click “Take Snapshot” or “Start Continuous Log.”

If you started a continuous log you need to click Stop Continuous log before accessing the
logs. The logs are automatically compressed and saved to your client system. If you click
Take Snapshot, click Save Snapshot to save the snapshot to a file.

Depending on your operating system the default logging directories for the ISIS Log Utility
are:

- Windows 7, Windows 8 (and 8.1), Windows 2008 servers and Windows 2012 servers —
C:\Users\<username>\ISISLogUtility

- Windows XP and Windows 2003 servers — C: \Documents and
Settings\<username>\ISISLogUtility

- Macintosh OSX — /Users/<username>/ISISLogUtility
- Linux — /home/<username>/ISISLogUtility

6. Click “Show Display” or “Save Snapshot” to view or save the results.

Changing Settings

The recommended default settings are saved in each Profile. You should not change the
predefined settings unless instructed to by Avid Customer Support.

To change ISIS Log Utility test settings:
1. Do one of the following to start the ISIS log Utility:
» (Windows) Click Start > Programs > Avid > ISIS Client > ISIS Log Utility.

» (Macintosh) From the Finder, click the Go menu and select Application > AvidISIS >
ISISLogUtility.app.

» (Linux) Click Application > System Tools > ISIS Log Utility.
2. Select a profile from the Select Profile menu.
3. Click Load.

The configuration for the selected Profile is loaded.
To view the test configuration that was loaded, click the Configure button.

4. Click “Current Settings” in the Tools section to change settings in the configuration.
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Changing Settings
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. Select or deselect the changes you want in the Snapshot Options, Trace Buffer Filtering, and
Continuous Logging sections of the window.

. Click the Browse button to define where you want the log files to be saved or type in the new
path.

. Click Apply to save your changes and have them loaded in the test configuration.
Click Reset to return all the options and path back to the original defaults.
8. Close the window.

. Run the utility: see “Running the ISIS Log Utility” on page 88.
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